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Data Envelopment Analysis with deaR dR

1. INTRODUCTION.

deaR is a new and versatile R package (free software) that allows to run a wide variety of
models based on Data Envelopment Analysis.

This tutorial is written so that non-R users can use deaR, but it is not a manual of
introduction to R™.

If you are an R user, you can directly go to section 5 and 7.

We want deaR to become the reference software tool for those researchers, practitioners,
teachers, students and users of the Data Envelopment Analysis methodology. For this, any
comments and suggestions to improve deaR will be really appreciated. We also accept
suggestions of DEA models to be considered for being programmed in new versions of deaR.
In this sense, we like to anticipate that a new version of deaR will include models or features
not currently covered such as: stochastic DEA, network DEA, Malmquist index (other
decompositions and bootstrapping), negative values and extension of undesirable
inputs/outputs to other models in which they are not available now, etc.

We will release a deaR shiny version (an interactive web app) soon. We will inform you
when it available.

2. Download and Install R and RStudio.
To use deaR, firstly we have to download and install R and Rstudio.
2.1. Rinstallation.

To install R, we go to the R-project website: http://www.r-project.org (see Figure 1).

Figure 1. R-project website.

R R The R Project for Statistical (¢ X | =+

c o @ @ https:/www.r-project.org ome w

R The R Project for Statistical Computing

Getting Started

R is a free software environment for statistical computing and graphics. It compiles and runs on a wide
variety of UNIX platforms, Windows and MacOS. To download R, please choose your preferred CRAN
mirror.

Home]

Download
CRAN
If you have questions about R like how to download and install the software, or what the license terms

R Project are, please read our answers to frequently asked guestions before you send an email

About R

Logo News

Contributors

What's New? « The R Foundation Conference Committee has released a call for proposals to host useR! 2020 in
Reporting Bugs North America

Conferences = You can now support the R Foundation with a renewable subscription as a supporting member

Search

Get Involved: Mailing Lists
Developer Pages = The R Foundation has been awarded the Personality/Organization of the year 2018 award by the
R Blog professional association of German market and social researchers

= R version 3.5.1 (Feather Spray) has been released on 2018-07-02.

To download R, we click the CRAN link and select the “mirror site” nearest to our location.

Now, depending on the operating system of our computer, we select the appropriate option
(see Figure 2).

!Manual of introduction to R: https://cran.r-project.org/doc/manuals/r-release/R-intro.pdf
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Figure 2. Versions of R.

The Comprehensive R Archive Network

Download and Install R

Precompiled binary distributions of the base system and contributed packages, Windows and Mac users most likely want one of
these versions of R:

* Download R for Linux
» Download R for (Mac) O5 X
* Download R for Windows

R is part of many Linux distributions, you should check with your Linux package management system in addition to the link
above.

a) Installing R on Windows.

By clicking the Download R for Windows link, we will go to the webpage shown in the Figure
below. We click on install R for the first time (see Figure 3).

Figure 3. R for Windows.

R for Windows

Subdirectones:

base Binaries for base distribution. This 1s what you want gfi rst time.

conteih Binaries of contributed CRAN packages (for R >= 213X e t¥8es). There is also information on third
e party software available for CRAN Windows services and conesponduig environment and make variables

old contnib Binaries of contributed CRAN packages for outdated versions of R (for R < 2.13 x; managed by Uwe Ligges).

Rtools Tools to build R and R packages. This is what you want to build your own packages on Windows, or to build R itself.

Please do not submit binaries to CRAN. Package developers might want to contact Uwe Ligges directly in case of questions / suggestions related to Windows binaries

You may also want to read the R FAQ and R for Windows FAQ.

Note: CRAN does some checks on these binaries for viruses, but cannot give guarantees. Use the normal prec with do exec

Next, we click on Download R 3.5.1 for Windows and save the installation file (see Figure 4)

Figure 4. Download R for Windows.

R-3.5.1 for Windows (32/64 bit)

mm R 3.5.1 for Windows [§2 megabytes. 32/64 bit)

Installa 1ons
New features in this version

If you want to double-check that the package you have downloaded matches the package distributed by CRAN, you can compare the md3sum of the exe to the
fingerprint on the master server. You will need a version of md3sum for windows: both graphical and command line versions are available.

Frequently asked questions

* Does R run under my version of Windows?
» How do I update packages in my previous version of R7
» Should I run 32-bit or 64-bit R?

Please see the R FAQ for general information about R and the B Windows FAQ for Windows-specific information.

Now, we open the downloaded file (by double-clicking on the file) to install R.

b) Installing R on Mac.

By clicking the Download R for (Mac) OS X link, we will go to the webpage shown in the
Figure below. We click on R-3.5.1.pkg to download the installation file (see Figure 5).

©Coll-Serrano, V.; Benitez, R. and Bolds, V. J. (2018)
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Figure 5. R for Mac.

R for Mac OS X

This directory contains binaries for a base distribution and packages to run on Mac OS X (release 10.6 and above). Mac OS 8.6 to 9.2 (and Mac OS X 10.1) are no
longer supported but you can find the last supported release of R for these systems (which 1s R 1.7.1) here. Releases for old Mac OS X systems (through Maec OS X
10.5) and PowerPC Macs can be found in the old directory.

Note: CRAN does not have Mac OS X systems and cannot check these binaries for viruses. Although we take precautions when assembling binaries, please use the
normal precautions with downloaded executables.

As 0f 2016/03/01 package binaries for R versions older than 2.12.0 are only available from the CRAN archive so users of such versions should adjust the CRAN
mirror setting accordingly.

R 3.5.1 "Feather Spray" released on 2018/07/05

Important: since R 3.4.0 release we are now providing binaries for OS X 10.11 (El Capitan) and higher using non-Apple toolkit to provide support for OpenMP
and C++17 standard features. To compile packages you may have to download tools from the tools directory and read the corresponding note below.

Please check the MD3 checksum of the downloaded image to ensure that it has not been tampered with or corrupted during the mirroring process. For example type
md5 R-3.5.1.pkg

in the Terminal application to print the MD5 checksum for the R-3.5.1 pkg image. On Mac OS X 10.7 and later you can also validate the signature using
pkgutil --check-signature R-3.5.1.pkg

Lastest release:

R 3.5.1 binary for OS X 10.11 (El Capitan) and higher. signed package. Contains R 3.5.1 framework.
RTINS s R.app GUI 1.70 in 64-bit for Intel Macs, Tcl'Tk 8.6.6 X11 libraries and Texinfo 5.2. The latter two
R components are optional and can be ommitted when choosing "custom install”, they are only needed 1f
vou want to use the celtk R package or build package documentation from sources.

(ca. T4MB)

Note: the use of X11 (including tclck) requires XQuartz to be installed since it 1s no longer part of
08 X Always re-mnstall XQuartz when upgrading your macOS to a new major version.

Important: this release uses Clang 6.0.0 and GNU Fortran 6.1. neither of which is supplied by Apple.
If you wish to compile R packages from sources. you will need to download and install those tools -
see the tools directory.

We open R-3.5.1.pkg and follow the instructions to install R.

2.2. RStudio installation.

Once we have installed R, we download RStudio from the following link (see Figure 6):

https://www.rstudio.com/products/rstudio/download/#download

Figure 6. Download RStudio.

9 Studio

RStudio Desktop 1.1.463 — Relea

7]

RStudio requires R 3.0.1+. If you don't already have R, download it here.
Linux users may need to import R5tudio's public code-signing key prior to installation, depending on the operating system's security

policy.

Installers for Supported Platforms

Installers Size Date MD5

85.8MB 2018-10-28 58b3d796dBcf96fbB580c62f46abb4dd

RStudio 1.1.

T45MB 2018-10-29 a75032ba4d7daaal6aBda01548278d54

893MB 2018-10-28 Bae7S5S5faSfaeZbafce2B89df3358aafe3

974MB 2018-10-23 bc50debd34926clcc3ae4a209d67dE49

65 MB 2018-10-29 cfd655db18619cc7Bd1592fefaa7c753

88.1MB  2018-10-28 742f0bad&0dfeaa3281576el4adEe55%e

906MB 2018-10-28 <¢7303067a0ca%9deeca7e427b856352d1

To download the executable file, we select the option according to our operating system:
e RStudio 1.1.463 - Windows Vista/7/8/10
e RStudio 1.1.463 - Mac OS X 10.6+ (64-bit)

©Coll-Serrano, V.; Benitez, R. and Bolds, V. J. (2018)
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First, we save the file. Then, we open it to install RStudio. We follow the installation
instructions.

3. Getting started with RStudio.

In general, we use RStudio instead of R because of the friendly interface of the former.
To boot up RStudio, we click on the RStudio icon: | B

By opening RStudio, we should see something like the Figure 7:

Figure 7. The RStudio interface.

[3) RStudio - o]
File Edit Code View Plots Session Build Debug Profile Tools Help

Environment History Connections
’

“ud #* Import Dataset = ¥ List =
R version 3.4.2 (2017-09-28) -- "Short Summer" =
Copyright (C) 2017 The R Foundation for Statistical Computing MiGichalEnvironmentis
Platform: x86_64-wb4-mingw32/x64 (64-bit)

R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain conditions.
Type 'license()' or 'licence()' for distribution details

R is a collaborative project with many contributors.
Type 'contributors()' for more information and
'citation()' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-1ine help, or LiotHlibocksoetal Help [ Vimwey

'help.start(Q' for an HTML browser interface to help. QT New Folder | @  Delete 4 Rename | &f More ~

Type 'q(0' to quit R. &Y Home

@ A Name size Modified

I
] Files and folders in
[ My documents
.

By default, the Console is in the left side. After a brief informative text, the system prompt
appears (“>"). Can you see the flashing cursor? Here is where we can write the commands or
instructions to be run (by R). To execute an instruction in the Console and get the result we
press Enter.

3.1. How to create a script.

Working in the Console is very limited since in the Console the instructions are generally
written and executed one by one. For this reason, it is usual working with scripts or
instructions files. These files have the extension “.R”.

To create a script we select File > New File > R Script.

Now, the script is the top left panel and the Console is the bottom left panel. By default, the
name of the script is “Untitled1” (see Figure 8).

In a script we can write the instructions line by line. The instructions can be run one by one
or we can select all (or some) of them and run the selection. We click on “#Run to run them.

©Coll-Serrano, V.; Benitez, R. and Bolds, V. J. (2018)
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Figure 8. Script.
[E) RStudio -
File Edit Code View Plots Session Build Debug Profile Tools Help

@ | Untitled1 Environment  History Connections

’

ind #* Import Dataset = ¥ List =

Source on Save R /- = Run | *% Source -

1| & Global Environment =

Files Plots Packages Help Viewer
<}__ New Folder @  Delete | Rename ‘L;'}Mure'

/I\ Home
A Name Size Modified
1:1 (Top Level) 2 R Script 3 [ ]

Consle : BN  Files and folders in
You are welcome to redistribute it under certain conditions. ~ - My documents
Type 'license()' or 'licence()' for distribution details. .

R is a collaborative project with many contributors. -

Type 'contributors()' for more information and
‘citation()"' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or
'help.start(Q' for an HTML browser interface to help.
Type 'g()' to quit R.

>

4. How to create and work with projects in RStudio.

Once we boot up RStudio, we should set the working directory to indicate R and RStudio
where our data, scripts, etc. are. However, in our opinion, the best option is to create a
project in RStudio. Creating a project, all the files (data, scripts, etc.) and directories inside
the project are directly linked to the project. That is to say, all the work on a project will be
self-contained in the directory of the project. In this way, we can easily share the project
with someone else or copy-paste the project in another computer, etc.

Important note:

We create a project for each activity/work (for example, for each
article/paper).

To organize a project properly, we recommend to create specific
directories for raw data, results, text documents, etc.

4.1. Creating a project.

To create a project in RStudio, we select File > New project... We should see something
similar as the Figure below:

©Coll-Serrano, V.; Benitez, R. and Bolds, V. J. (2018)
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Figure 9. Create a project.

New Project

Create Project

1 New Directory
o

Start a project in a brand new working directory

Existing Directory
L= R» Associate a project with an existing working director

F Version Control
Checkout a project from a version control repositor

Cancel

To create a project in a new directory, we click on the New Directory button. Then, we select
the type of project. In our case, New Project. Now, we name the directory (or folder) that we
are creating. It will also be the name of the project. Finally, we click on Create Project.
Following this process, a folder in Documents will be created, and inside it we will find the
file: "folder_name.Rproj".

To create a project in an existing directory, we click on the Existing Directory button, and
then we select the directory or folder by clicking on the Browse... button. Finally, we click on
Create Project.

4.2. Opening a project.

To open a Project we double click on the file with extension “.Rproj”. We can also open the
project from the RStudio menu: File > Open Project...

Advantage of projects: any file we save while we are working in a project will be saved inside
the project’s directory.

4.3. Additional information.

Here you have two readings about projects in RStudio. The second reading includes
information about how to create projects.

e https://www.r-bloggers.com/managing-projects-using-rstudio/

e https://www.ssc.wisc.edu/sscc/pubs/RFR/RFR Projects.html#projects

4.4. How to create a project.

Step 1. Open RStudio

Step 2. Select File > New Project

Step 3. Select New Directory

Step 4. Project Type: select New Project

Step 5. Directory name: Paper_1

Step 6: Create project as subdirectory of: by using the Browse, select the route where
the project folder will be created. For example, select the Desktop folder.

Step 7. Click on Create Project

©Coll-Serrano, V.; Benitez, R. and Bolds, V. J. (2018)
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Result: The “Paper_1" folder will be created in the Desktop folder. This folder will have two

files (see Figure 10).
= Paper_1 (type: R Project)

= .Rhistory (type: RHISTORY file)

Figure 10. Project “Paper_1".
(%) C/Use: -olEN
File Edit Code View Plots Session Build Debug Profile Tools Help
Q| Untitled1 ] Environment  History Connections N
Source on Save A ) * Run " Source f ** import Dataset « y/ 5t -
1 % Giobal Environment =
Plots Packages Help Viewer ™
Q. NewFolder @ Delete = Rename g More -
Use Vicente
AN
RS L
— [o]:] Nov 1, 2018, 8:19 Al
= 218 B Nov 1, 2018, 8:20 Al

Console cent
You are welcome to redistribute it under certain conditions. =
Type 'license(Q' or 'licence()' for distribution details.

R is a collaborative project with many contributors.
Type 'contributors()' for more information and
‘citation()" on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or
'help.start()' for an HTML browser interface to help.

Type 'q()' to quit R.

>

Important note:

The working session with a project will be always opened

double-clicking on the file with extension “.Rproj”
or
File > Open Project and selecting the project

Working simultaneously with several projects is not recommended.

5. How to install and load deaR.

Open RStudio or the project: “Paper_1".

Select File > New File > R script

5.1. Installing deaR.

To install deaR, we write into the script:
install.packages(“deaR”)

and we run the instruction. For that, we click on the Run button: “#Rrun (see Figure 11).

By clicking on the Packages menu in the bottom right window, a list of all installed packages
will be shown. Now, deaR package should be listed.

©Coll-Serrano, V.; Benitez, R. and Bolds, V. J. (2018)
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Important note:

We have to install deaR only once. Then, we can get
the new deaR versions updating the package.

Figure 11. Install deaR.

(%) C:/Users/Vicente/Desktop/Paper_1 - RStudio - g -_
File Edit Code View Plots Session Build Debug Profile Tools Help
@ | Untitled1* - Environment History Connections -
| Sourceonsave | O 7 - ik, 4 Source ~ T k| ©2* import Dataset ~ r's List =
1 install.packages("dear") fk Global Environment =
onment is e
Files PIMsHeIp Viewer P |
&l instal | @ pazte | Wl Packrat
Name Description Version
— T =
csvy Import and Export CSV Data with a YAML  0.3.0
1:24 (Top Level) = R Script = Metadata Header
curl A Modern and Flexible Web Client forR 3.2
Conscle C:/Users/Vicente/Desktop/Paper_1/ = L s z
- - = - — data.table Extension of ‘data.frame’ 1.116
You are welcome to redistribute it under certain conditions. A o R Dabaa i 100
Type 'Ticense()' or 'licence()' for distribution details. atabaseiriterace ol
dbplyr A 'dplyr* Back End for Databases 1.2.2
R is a collaborative project with many contributors. deaR Conventional and Fuzzy Data 10
Type 'contributors(Q' for more information and Envelopment Analysis
Vot B ' B = . .
citation()' on how to cite R or R packages in publications. TS Debug R Packages K
Type 'demo()' for some demos, 'help()' for on-Tline help, or DEoptimR Differential Evolution Optimization in 1.0-8
‘help.start()' for an HTML browser interface to help. Pure R
Type 'g()' to quit R. desc Manipulate DESCRIPTION Files 120
devtools Tools to Make Developing R Packages 1136

>

Easier

5.2. Loading deaR.

Once we have installed deaR, or any other R package, to use it we have to load it first (see
Figure 12). For that, we write into the script:

library(“deaR”)

and we run the instruction clicking on the Run button:

Important note:

= Run

It is necessary to load deaR package in each working session.

©Coll-Serrano, V.; Benitez, R. and Bolds, V. J. (2018)
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Figure 12. Load deaR.

(%] C:/Users/Vicente/Desktop/Paper_1 - RStudio - g n_
File Edit Code View Plots Session Build Debug Profile Tools Help

@] untitled1* = Environment History Connections |

] Source on Save K S 5 Source F H # Import Dataset = = & List ~
install.packages ("deaR"

1 Global Environment ~

1.
2
3 library("dearR")
4

Files I’Iub Help  Viewer —

W install | @ Update | Wl Packrat

Name Descriptic Version

csvy Import and Export CSV Data with a YAML 0.3.0

41 Top Level) = R Script = Metadata Header
= curl A Modern and Flexible Web ClientforR 3.2
Console C:/Users/Vicente/Desktop/Pa — 2 . .

- = data.table Extension of ‘data.frame 1116

The following objects are masked from ‘package:stats’: et RDalabiase fifetinte 100

dhplyr A dplyr’ Back End for Databases 122

filter, lag Conventional and Fuzzy Data 10

) _ = Envelopment Analysis
The following objects are masked from ‘package:base’:

debugme Debug R Packages 110
intersect, setdiff, setequal, union DEoptimR Differential Evolution Optimization in 1.0-8
Pure R
warning message: desc Manipulate DESCRIPTION Files 120
Eackage ‘dplyr’ was built under R version 3.4.4 devtools Tools to Make Developing R Packages 1.136
= Easier

6. Save the script and close the working session.

To save the script, we select File > Save as...

Now, we name the file (for example: session_1) and click on the Save button. By default, the
script will be saved in the project folder: “Paper_1"”. Remember, this is an advantage of
working with projects.

Notice that the name of the R file (script) is “session_1.R” instead of “Untitled1” (see Figure
13). This file is shown in the list of files that are part of the project Paper_1.

Note: The content of this first script is completely irrelevant up to now. What is important is
to remember that we can save a set of instructions in a script.

Important note:

Give names to scripts that reflect their content.

©Coll-Serrano, V.; Benitez, R. and Bolds, V. J. (2018)
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Figure 13. Save script.

(%) C:/Users/Vicente/Desktop/Paper_1 - RStudio - g n_
File Edit Code View Plots Session Build Debug Profile Tools Help
" Environment History Connections =[]
/
Source on Save A S - *Run | "% Source ~ g “* Import Dataset = List =

1 dinstall.packages("dear") "} Global Environment =
2
3 Tlibrary("deaR")
4
5

P!nts Packages Help Viewer =
G New Folder | © Delete = Rename | g More ~

C: » Users » Vicente ~ Desktop ° Paper_1
4 Name Size Modified
5:1 (Top Level) 3 R Script = = .

- = “ ] .Rhistory 168 Nov 1,2018,11:05/
Console Users te/Desktop/Pap —

. . . . - £ p, 1.Rproj 18B Nov 1, 2018, 11
You are welcome to redistribute it under certain conditions. .y el el Bl o2 234
Type 'license()' or 'licence()' for distribution details. 47 B Nov 1, 2018, 11:26 4
R is a collaborative project with many contributors.

Type 'contributors()' for more information and
'citation()' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or
'help.start()' for an HTML browser interface to help.

Type 'qQ' to quit R.

>

If we want to close the project but not Rstudio: File > Close project

If we want to close the project and Rstudio: File > Quit Session

At this point, we save “session_1.R”, close the Project “Paper_1" and quit RStudio.

7. Data Envelopment Analysis with deaR.

We start by opening the project “Paper _1”. For that, we double click on the file
“Paper_1.Rproj”. RStudio and the project will open. Remember, you can also open RStudio
first and then the project (File > Open Project).

Next, we create a new script (File > New File > R Script). In this new script we write the
instruction to load deaR:

library(“deaR”)
(Note: we execute the instruction by clicking on the Run button = run ).

In the flow chart below (see Figure 14), we can see the steps to perform any DEA (Data
Envelopment Analysis) with deaR.

10
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Select dataset

Figure 14. Steps to use deaR.
dR First steps: No
Yes

step 1

Yes

Time
series?

Stepz | Read malmquist | I Read data | I Read Fuzzy data |

| |

!
Step 3 | Select DEA model |

7.1. Importing data into R.

The first step is to import the data we are going to use to perform a DEA analysis. The non-R
user can use the Import dataset option. Let’s see how to import data with Example 1.

m Import data into R data from an Excel file:

1. Download the data of the example from www.uv.es/vcoll/Coll Blasco 2006.xlsx
and save the file into the folder of the project “Paper_1”.

2. From RStudio Environment menu in the top left window, we select the option:
Import Dataset < From Excel (see Figure 15).

Figure 15. Import data from Excel.
7] C/Users/Vicente/Deskiop/Paper_1 - Rstudio - oIEN

Fle Edt Code View Plots Session Build Debug Profile Tools Help

- History C -

- | # Import Dataset = " ] List =

% Tibrary(dear W Gioval From Text (base)..

@] untitied1* —

Source on Save L 7S~ * Run | % Source =

From Text (readr)..

From SPSS..
From SAS..

From Stata.

Files Plots Packages Help Viewsr -
Q) New Folder | D Delete = Rename  {gh More ~

0 0 sk 3 Vienie.. Desktop. > Paperd
A Name Size Modified
R
Rhistory 168 Nov 2, 2018, 9:44 Al
&) Paper_1.Rproj 2188 Nov 2, 2018, 9:56 Al

The following objects are masked from ‘package:stats’: 9 sesion 1R 478 Nov 1, 2018, 11:26 4
% Coll_Blasco_2006.xlsx B84KB Oct 14,2018, 2:02 P
filter, lag

The following objects are masked from ‘package:base’:

Top Level) &

Console s

intersect, setdiff, setequal, union

warning message:
package ‘dplyr’ was built under R version 3.4.4
>
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3. The window Import Excel Data opens. We click on the Browse button to choose the
Excel file (“Coll_Blasco_2006.xIsx”)? and then on the Open button (see Figure 16).

Figure 16. Import “Coll_Blasco_2006.xIsx”.

[E] C:/Users/Vicente/Desktop/Paper_1 - RStudio - o
File Edit Code View Plots Session Build Debug Profile Tools Help

@ | Untitled1* P History ~ C =0
= ’
i Excel Dat: List =
. mpoart Excel Data
TRE L
2 )
File/Url:
Data Preview:
(2] Choose File [ ~ |
+ + Paper 1 v & P
Organizar v Nueva carpeta =y A ® f—
¥ Favoritos “  Nombre T
Auth¢
18 Descargas Rprojuser 0 (2 3
B Escritorio 2 po= E
1 Sitios recientes 14 ! {—
21 (Tog % Dropbox 2 R4l 1
ownClowd 7 - 2 2018, 9:44 Al
Console C:/U ]
~-| Import Options: — %, 2018, 9:56 Al
& Grupo en el hogar | — 3
The follow & ], 2018, 11:26/
Name: | dataset [} 9 uLL)
o & £ste cquipo g 4,2018, 202 P
ilten 10
Sheet  Default - < & Descargas
Documentos
The follow Range: » I Escritorio
. £l Imaaenes X I 2
inters
Nombre: | Coll_Blasco_2006 v
warning meg ?' Reading Excel files using readxl et Cancel
package ‘d

= —

4. Now, we can previsualize “Coll_Blasco 2006.xIsx” and the import data options
used (see left side in Figure 17). As you can see in the Figure below, the R code used
to import the data is shown in the bottom right side of this window (see Figure 17).
Since the Open Data Viewer is selected?, the dataset will be opened when the import
process concludes. For that, we click on the Import button.

Figure 17. Data preview.
L) C:/Users/Vicente/Desktop/Paper_1 - RStudio ~ o BEl

File Edt Code View Plots Session Build Debug Profile Tock Help

@ | Untitled1™ - i History G =

: 1 - List =
1 Tibry 'meort BxcelData
2

File/Url:

@D«asklopﬂapeg1;(0!I_Biasco_2006.alsx Browse...
IOata Preview: I

Authorized_dealer Employees Capital Vehicles Orders
A 8 8 14 20 =
B 1 15 25 42 =0
C 14 12 8 30
D 12 3 25 8
F 11 1] Aan 3 w| [d
1 Tl | Previewing first 50 entries.

£ 2018, 9d4 Al

Console C /1 5 =
g [t sl 2, 2018, 9:56 Al
The follow - library(readx]) 1. 2018, 11:26 4
: Mame: | Coll_Blasco_2006 Max Rows: + First Row as Names Coll_Blasco_2006 <- read_exce
filt i %) 4,2018,2:02P
1 en > i >
Sheet  Default - Skip: 0 | Open Data Viewer View.Col]_Blasco. 2006)

The follow

Range: NA:

inters

warning me 7 Reading Excel files using readxd @ Cancel
package °d

>

2 Coll-Serrano, V.; Blasco-Blasco, O. (2006). Evaluacidn de la Eficiencia mediante el Andlisis Envolvente de Datos.
Introduccidn a los Modelos Bdsicos. www.eumed.net/libros/2006¢/197/
3 It corresponds to the R code: View(Coll_Blasco_2006)
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dr

5. After clicking on the Import button, we come back to the main window of the
project “Paper_1". The imported data are shown in a new sheet (it has the same
name as the dataset) (see Figure 18). Besides, in the Environment menu (top right
panel) appears a list of all objects* that we are creating in R. Right now, we only have
one object: “Coll Blasco 2006”. Actually, this object is a dataframe with 6
observations and 5 variables.

Figure 18. Project “Paper_1".
5}

File Edit Code View Plots Session Build Debug Profile Tools Help

Coll_Blasco_2006

S R N

Showing 1

Console

Filter

Authorized_dealer Employees

A 8
B AR}
(& 14
D 12
£ 1
F 18

to € of 6 entries

Attaching package: ‘deaR’

The following object is masked _by.

Coll_Blasco_2006

warning message:
package ‘dplyr’ was built under R version 3.4.4

Capital Vehicles

*.GlobalEnv’:

Orders

> library(readxl)
warning message:
package ‘readx1’ was built under R version 3.4.4
> Coll_Blasco_2006 <- read_excel("Coll_Blasco_2006.x1sx")
> View(Coll_Blasco_2006)

o

C:/Users/Vicente/Desktop/Paper_1 - RStudio

,
¥y

#* Import Dataset =
"% Global Environment ~
Data

I Coll_Blasco_20.. 6 obs. of 5 variab'lesl

Files Plots Packages Help Viewer

= Q) NewFolder © Delete = Rename = 4gF More -

" C: * Users © Vicente © Desktop -~ Paper_
A Name Size
t.
'] Rhistory 6.7 KB
Coll_Blasco_2006.xlsx 84 KB
%) Paper_1Rproj 2188
@7 session_1R 478

Modified

Nov 11,2018,4:41 PM
Oct 14, 2018, 2:02 PM
Nov 14,2018, 4:16 PM
Nov 1,2018, 11:26 AM

We can see the R code used to import the data in the Console (see Figure 18):

library(readxl) - load the package: “readx/”

Coll_Blasco_2006 <- read_excel(“Coll_Blasco_2006.xlsx”) - the “read_excel”
function (from the readix package) reads the data file and assign (“<- “) the
data to the object “Coll_Blasco_2006".

Very important:

R terminology: A <- B This means that B (whatever B: a dataset, a function,

a matrix, the result of a mathematical operation, etc.) is assigned (<-) to the

object A.

View(Coll_Blasco_2006) —> visualize (View) the object “Coll_Blasco_2006".

6. We copy the above code into the script “Untitled1” and save it with the name
“session_2".

Our project should show something like that (see Figure 19).

4 Everything in R is an object. An object can be a dataset, a function, an instruction, a matrix, etc.
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Figure 19. Save script “session_2".
5]

C:/Users/Vicente/Desktop/Paper_1 - RStudio - o IEl
File Edit Code View Plots Session Build Debug Profile Tools Help

Coll Blasco_2006 —["  Envi History  Connecti =
;

| [ Source on Save A /- +Run | % Source = 2 | | £7* import Dataset = | & List =
; Tibrary(deaR) "} Global Environment =
3 library(readxl) Data
4 Coll_Blasco_2006 read_excel ("Col1_Blasco_2006.x1sx") coll_Blasco_20.. 6 obs. of 5 variables
5 View(Coll_Blasco_2006)
6
611 (Top Level) = RScipt = Files Plots Packages Help  Viewer =l
et B e B T ™ QU NewFoider | © Delete s Rename 4 More -
- C: > Users » Vicente » Desktop * Paper_1 [
A Name Size Modified
Attaching package: ‘deaR’ .
The following object is masked _by_ ‘.GlobalEnv’: “] Rhistory 6.7KB Nov 11, 2018, 4:41 PM
| Coll_Blasco_2006.xlsx 84 KB Oct 14,2018, 2:02 PM
Call_Blasco 2008 Bl paper 1.Rproj 2188 Nov 14, 2018, 4:16 PM

[}

warning message: gssion 1.R 47 B Nowv 1,2018, 11:26 AM
I)d%lfgqe ‘léuwg];vas built under R version 3.4.4 1578 Nov 2, 2018, 11:28 AM
> library(readx

warning message:

package ‘readx1’ was built under R version 3.4.4

> Col1_Blasco_2006 <- read_excel("Coll_Blasco_2006.xTIsx")
> View(Coll_Blasco_2006)

>

It will not be necessary to repeat steps 1-5 on all subsequent sessions because we
have the whole code in the file “session_2.R”. To import the data from
“Coll_Blasco_2006.xIsx” again, we only have to execute the code in “session_2.R”.

deaR also provides a large collection of datasets. These datasets come from articles already
published and they are used to replicate the results of the articles. We think this is a great
added value that deaR offers both researchers and practitioners, since it can be an
important help and support for teaching and learning DEA methodology. We can see the
structure and source of the data by getting help from deaR®.

Let’s see how to load a dataset in Example 2.

m Loading datasets available in deaR.

To see what datasets are available in deaR, we write
data(package="deaR"”)

and run the instruction.

5> Getting help with R: https://www.r-project.org/help.html
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Figure 20. Datasets proviede by deaR.

[E] C:/Users/Vicente/Desktop/Paper_1 - RStudio -0 “_
File Edit Code View Plots Session Build Debug Profile Tools Help

') session_2R* - History C =

T ’
FH ¥ import Dataset = = List =
~
Data sets in package ‘deaR’: & Global Environment ~
Data

Coll_Blasco_2006 Data: Coll and Blasco (2006). Coll.Blasco 206 obs. of 5 variables

Departments Data: Tomkins and Green (1988).
Doyle Green 1994 Data: Doyle and Green (1994).
Economy Data: Wang and Lan (2011).
EconomyLong Data: Wang and Lan (2011).
Electric_plants Data: Fare, Grosskopf and Kokkelenberg
(1989).
Fortunes00 Data: Zhu (2014).
Fried1993 Data: Fried, Knox Lovell and Schmidt
(1993).
Golany Roll 1989 Data: Golany and Roll (1989). v Files Plots Packages Help Viewer ="
Clibie C RNk DA o Pasari] = Q7 NewFolder @ Delete = Rename | g More -
& C: » Users » Vicente  Desktop * Paper_1 &
Attaching package: ‘deaR’ A Name Size Modified
i : - t.
The following object is masked _by_ ‘.Globalenv':
] .Rhistory 6.7 KB Nov 11,2018, 4:41 PM

Coll_Blasco_2006 ] Coll_Blasco_2006xsx 84 KB Oct 14, 2018, 2:02 PM
warning message: Rl Paper_1.Rproj 2188 Nov 14,2018, 4:16 PM
package ‘dplyr’ was built under R version 3.4.4 @7 session_1.R 478 Nov 1, 2018, 11:26 AM
> Tibrary(readxl) 9 session_2.R 1578 Nov 2, 2018, 11:28 AM

warning message:

package ‘readx1' was built under R version 3.4.4

> Coll_Blasco_2006 <- read_excel("Coll_Blasco_2006.x1sx")
> View(Col1_Blasco_2006)

> data(package="dear")
>

To load a dataset we use the data() function. For example, we are going to load the data
from Tomkins and Green (1988)8. The name of this dataset is “Departments”. Therefore, we
write into the script “session2.R” (see Figure 21):

data(“Departments”)
If we want to visualize the dataset, we write (see Figure 21):

View(Departments)

Figure 21. Load and view data.

(2] C:/Users/Vicente/Desktop/Paper_1 - RStudio - o IEN
File Edit Code View Plots Session Build Debug Profile Tools Help

Q| sesion_2R Departments | R data sats o Environment  History Connections =M
Source on Save L /- = Run i Source ~ =/l #* Impert Dataset = '3 List =
% Tibrary(deaR) ™ Global Environment =
3 Tibrary(readx1) bata
4 Coll_Blasco_2006 <- read_excel("Coll_Blasco_2006.x1sx") 2Coll_Blasco_20. 6 obs. of 5 variables
5 i
6 data(package="deaR™ ) Departments 20 obs. of 11 variables
8 data("Departments')
9  View(Departments)
10
Files Plots Packages Help Viewer o
Q0 New Foider | © | Delete = Rename | ¥ More -
C: * Users ° Vicente ~ Desktop * Paper_) B
A Name Size Modified
10:1 (Top Level) = R Saript = B
— @7 RData 2B KB Nov 2, 2018, 11:09 AM
Console C:/Users/Vicente/Desktop/Paper_1 o= ’
> Tibrary(deaR) 1 .Rhistory 1258 Nov 2, 2018, 11:09 AM
> library(readx1) __| Coll_Blasco_2006.xsx 84 KB Oct 14, 2018, 2:02 PM
> Coll _B]as(o__ZI.J.Uﬁ < read_excel("Col1_Blasco_2006.x1sx™) % Paper_1 Rproj 2188 Nov 2, 2018, 11417 AM
> data(package="deaR")
> data("Departments™) 9 ] sesion_1.R 47B Nov 1, 2018, 11:26 AM
> View(Departments) @ sesion_2R 1578 Nov 2, 2018, 11:28 AM
>

We execute the instructions by clicking on ~=# run (see Figure 22).

® Tomkins, C.; Green, R. (1988). "An Experiment in the Use of Data Envelopment Analysis for Evaluating the
Efficiency of UK University Departments of Accounting”, Financial Accountability and Management, 4(2), 147-
164. https://doi.org/10.1111/j.1468-0408.1988.tb00296.x
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Figure 22. “Departments”.

(%) C:/Users/Vicente/Desktop/Paper_1 - RStudio - g “_
File Edit Code View Plots Session Build Debug Profile Tools Help

@ | session_ 2R Departments __| Rdata sets - Environment History Connections =
7 ¢

’ Filter S | #* Import Dataset = | & List ~
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2 Department? 8335 9 0 5 »Col11_Blasco_20_ 6 obs, _of 5 variables
3 Department3 92.77 10 10 2162 @rtments SOon> ol Va@
4 Departmentd 80.03 4 0 0
5§ Department5 119.85 3 14 0
6 Departmenté 112.69 4 25 150
v
< >
SRy Uy e s Files Plots Packages Help Viewer ——n
e T D ST Y .~ ClNewroder | © Delete = Rename | Gk More - :
> Tibrary(deaR) C: © Users * Vicente - Desktop * Paper_1 2
> library(readxl1) A Name Size Modified
> Coll_Blasco_2006 <- read excel("Coll_Blasco_2006.x1sx") 1t [
> View(Col1_Blasco_2006) "
> data(package="dear") @) RData 36KB Nov 14, 2018, 4:45 PM
> data("Departments") “| .Rhistory 7KB Nov 14, 2018, 4:45 PM
> View(Departments) 2
> | Coll_Blasco_2006.xlsx 84 KB QOct 14, 2018, 2:027 w,"
R Paper_1.Rproj 2188 Nov 14, 2018, 4:45'711
@] session_1.R 47B Nov 1, 2018, 11:26 AM
@) session_ 2R 1818 Nov 14, 2018, 4:44 PM

Notice that we now have two objects: “Coll Blasco 2006” and “Departments”.
“Departments” is a dataframe consisting of 20 observations (DMUs) and 11 variables.

Now, we save “session_2.R” and close the project “Paper_1". Quit RStudio.

7.2. Adapting the data to deaR

Once the data have been loaded, the next step is to adapt them to the format that deaR
uses to read them. deaR has three different data reading functions. Each reading function
responds to a typology of DEA model. These reading functions are:

Read_data(): if we are going to run a conventional DEA model.
Read_malmaquist(): if we want to perform the Malmquist productivity index.

Read_data_fuzzy(): if we want to run a DEA model with uncertain data (fuzzy DEA).

7.2.1. Getting help from deaR’.

We can learn how to use a specific function by using the help from deaR. In the help for
deaR we can read about the arguments of a function or examples about how to use it. Let’s
see how to use the help function with Example 3.

m Getting help for deaR.

1. We open the project “Paper_1" and create a new script. We name the script:
“example_read_data”

2. We load deaR
3. We load the dataset provided by deaR: “Coll_Blasco_2006” (see Figure 23).

7 Getting help with R: https://www.r-project.org/help.html
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Figure 23. Load dataset: “Coll_Blasco_2006"
0
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Attaching package: ‘dplyr’ t
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X Y] Rhistory 73KB Nov 14, 2018, 4:52 PM
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The following objects are masked from ‘package:base’: @] example_read_data.R 458 Nov 14, 2018, 452 PM
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intersect, setdiff, setequal, union : par_topro
@ session_1.R 478 Nov 1,2018, 11:26 AM
Warning message: 0] session_2R 1818 Nov 14, 2018, 4:44 PM

package ‘dplyr’ was built under R version 3.4.4

> data("Col1_Blasco_2006")
>

To access the documentation for a function of the package deaR we use the help()

function. We write:

help(package="deaR")

In the Help menu (see bottom right window) a list of all functions and datasets in
deaR will appear. It is the documentation for the package (see Figure 24).

Figure 24. Help for deaR.

(%] C:/Users/Vicente/Desktop/Paper_1 - RStudio - g n_
File Edit Code View Plots Session Build Debug Profile Tools Help
@) example_read_data.R* History  Ce i =
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> help(package="dear™")
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Envelopment Analysis

stats’:

DO

base’:

IDocumentation for package 'deaR’Iversion
1.0

« DESCRIPTION file

. Help Pages v
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7.2.2. read_data() function:

Once we have accessed the documentation (help) for deaR, if we clic on the “read_data” link
we will get the specific help about this function. We can also get the same result if we write:

help(read_data) (or ?read_data)
into the script and run the instruction.

All the arguments of the read data() function are listed in the Usage section, and in the
Arguments section we can read a brief explanation of them (see Figure 25).

Figure 25. Help for read_data() function.

Q C:/Users/Vicente/Desktop/Paper_1 - RStudio su: 0 “_
File Edit Code View Plots Session Build Debug Profile Tools Help

@ | example_read_dataR" =l Environment  History Connections |
Sourceon Save | O/~ *Run | o= Source ~ o # Import Dataset = = & List ~
; library(deaR) ™ Global Environment ~
3 data("coll_Blasco_2006" Values
4 Coll_Blasco_20.
5 help(package="deaR")
6

Files Plots Packages Viewer P

6:1 Top Level) < R Seript & D
Console © Desktop, P R: read_data ~
P T "
Attaching package: ‘dplyr’ rea_ ata
The following objects are masked from ‘package:stats’: Description
filter, lag This function creates, from a data frame, a deadata structure, which is as list

with fields input, output, dmunames, nc_inputs, nc_outputs,
nd_inputs, nd outputs

intersect, setdiff, setequal, union

warning message:

The following objects are masked from ‘package:base’:

package ‘dplyr’ was built under R version 3.4.4 readidaca(dacaldea,i

> data("cCol1_Blasco_2006") amui 7111

> help(package="deaR") ni = NULL,

> no = NULL, v

The read_data() function takes the following arguments:
e datadea: It is the dataset (It must be a dataframe).

e dmus: Number of the column where the DMUs are. By default, deaR considers DMUs
are in the first column of the dataset.

e ni:ltis the number of inputs.
e no: Itis the number of outputs.

e jnputs: We can indicate the numbers of the columns where the inputs are instead of
indicating the number of inputs.

e QOutputs: We can indicate the numbers of the columns where the outputs are instead
of indicating the number of outputs.

e nc_inputs: If we have non-controllable inputs, we can indicate which are them.

e nc_outputs: If we have non-controllable outputs, we can indicate which are them.
e nd_inputs: If we have non-discretionary inputs, we can indicate which are them.

e nd_outputs: If we have non-discretionary outputs, we can indicate which are them.
e ud_inputs: If we have undesirable (bad) inputs, we can indicate which are them.
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e ud_outputs: If we have undesirable (bad) outputs, we can indicate which are them.

Example 4 shows how to use the read data() function. The documentation for deaR
provides examples for the all functions in the package.

FET RN Using the read_data() function.

Currently, we have loaded the dataset “Coll_Blasco_2006". This dataset has 6 DMUs (column
1), 2 inputs (columns 2 and 3) and 2 outputs (columns 4 and 5).

Suppose that we want to measure the efficiency of these DMUs using the BCC DEA model.

As BCC model is a conventional DEA model (it is not a fuzzy DEA model), we must use the
read_data() function to adapt the original dataset to the format used by deaR.

We write the following text into the script “example_read_data” (see Figure 26):

data_example <- read_data(Coll_Blasco_2006, ni=2, no=2)

Very important: Reading and understanding the instruction.

The expression on the right side of the assignment symbol (<-) means: read the
data (read_data) in Coll_Blasco_2006; it has 2 inputs (ni=2) and 2 outputs(no=2).
DMUs are in column 1 (dmus=1). This argument doesn’t appear since it is the
default value.

Then, the result of this function is assigned (<-) to the object data_example.

We execute the instruction (= Run ).

Notice that now the objects “Coll Blasco_2006” and “data_example” appear listed in the
Environment menu. Notice also that “data_example” is a list of 9 components. (see Figure
26).

Figure 26. Using the read_data() function.
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Description
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Usage
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©Coll-Serrano, V.;

19
Benitez, R. and Bolds, V. J. (2018)



Data Envelopment Analysis with deaR dR

Now, the data are ready to be used with a conventional DEA model (see section 7.3.). For
that, we should use the object we have created: “data_example”.

Recommendation: Practice the function read data() with the examples in the
documentation.

7.2.3. read_malmquist() function.

If we have time series data and we want to measure the Malmquist productivity index, we
must use the read_malmquist() function first to adapt them to the format that deaR reads.

deaR admits the time series data in two different formats:

e Wide format: DMUs by column. Inputs and outputs of different periods of time
by column. For example, see the dataset “Economy”® in deaR (Figure 27).

e Long format: Time by column. DMUs, inputs and outputs by column, but grouped
by time. For example, see the dataset “EconomylLong” in deaR (Figure 28).

In the following example we try to show the above explanation.

m Wide and Long data formats.

Now, we are going to show these different data formats. For that:
1. We create a new script. Name it: “example_read_malmquist”.

Note: If we have closed the working session, we open the project “Paper_1" and then
create the new script. We also have to load deaR.

2. We load the dataset in deaR: “Economy” (see Figure 27).

3. Visualize “Economy”. This object (dataset) has 31 DMUs with 2 inputs (Capital and
Labor) and 1 output (GIOV) for 5 years (from 2005 to 2009). “Economy” is a dataset in
wide format.

8 Wang, Y.; Lan, Y. (2011). "Measuring Malmquist Productiviy Index: A New Approach Based on Double
Frontiers Data Envelopment Analysis". Mathematical and Computer Modelling, 54, 2760-
2771. https://doi.org/10.1016/j.mcm.2011.06.064

20
©Coll-Serrano, V.; Benitez, R. and Bolds, V. J. (2018)



Data Envelopment Analysis with deaR

yll .

Figure 27. Wide data format: “Econom
o
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>
>
ES

Now, load the dataset “EconomylLong”.

We visualize “EconomylLong” (see Figure 28). This new R object (actually, it is a
dataset) has 155 observations (31 DMUs x 5 years), with 2 inputs (Capital and Labor)
and 1 output (GIOV). The Period column refers to the time period 2005-2009.

. L ”
Figure 28. Long data format: “EconomylLong”.
(%) C/Users/Vicente/Desktop/Paper_1 - RStudio - o n_
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Console C:/Users/Vicente/Desktop/Paper_1/ = C . Users - Vicente - Desktop & Paper_1 X
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. . ) 3
intersect, setdiff, setequal, union @ Rpata p— Nov 14,2018, 445 PM
warning message: N} .Rhistory 73 KB Nov 14, 2018, 4:52 PM
package ‘dplyr’ was built under R version 3.4.4  Coll_Blasco_2006xlsx 84KB Oct 14, 2018, 202 PM
> data("Col1_Blasco_2006")
> help(package="deaR") o) example_read_data.R 45B Nov 14, 2018, 4:52 PM
> data_example <- read_data(Coll_Blasco_2006, B Paper_1.Rproj 2188 Nov 14, 2018, 4:52 PM
+ ni=2, @ - 5
2 no=2) | session_1.R 478 Nov 17,2018, 11:26 AM
> data("Economy") @] session_2R 181B Nov 14,2018, 444 PM
o) example_read_data_malmquistR 3018 Nov 8, 2018, 5:06 PM

Note: Notice that all objects we are creating during the working session

the Environment menu (top right window).

are listed in
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The read_malmaquist() function takes the following arguments®:

datadea: It is the dataset (It must be a dataframe).
nper: It is the number of years (with data in wide format).

percol: 1t is the number of the column where the variable time is (with data in long
format).

arrangement: “horizontal” with data in wide format or “vertical” with data in long
format.

dmus: Number of the column where the DMUs are. By default, deaR considers DMUs
are in the first column of the dataset.

ni: It is the number of inputs.
no: It is the number of outputs.

inputs: We can indicate the numbers of the columns where the inputs are instead of
indicating the number of inputs.

Outputs: We can indicate the numbers of the columns where the outputs are instead
of indicating the number of outputs.

nc_inputs: If we have non-controllable inputs, we can indicate which are them.
nc_outputs: If we have non-controllable outputs, we can indicate which are them.
nd_inputs: If we have non-discretionary inputs, we can indicate which are them.
nd_outputs: If we have non-discretionary outputs, we can indicate which are them.
ud_inputs: If we have undesirable (bad) inputs, we can indicate which are them.

ud_outputs: If we have undesirable (bad) outputs, we can indicate which are them.

The current version of deaR cannot manage undesirable inputs/outputs to calculate the
Malmaquist productivity index. This feature will be incorporated in a future version.

In Examples 6 and 7 we can see how to use the read_malmaquist() function with wide and
long data respectively.

FETNTJLAN read _malmaquist() function with wide data format.

For this example, we are going to use the dataset “Economy”. This dataset is already loaded
in the current working session.

To adapt “Economy” to the reading format used by deaR, we write into the script
(“example_read_malmquist”) the following text:

data_example_1 <- read_malmquist(Economy,
nper=5,
arrangement="horizontal”,
ni=2,
no=1)

% See help(read_malmquist).
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By running the instruction, a new object is created (“data_example_1") and listed in the

Environment (see Figure 29).

Figure 29. read_malmaquist() funtion with wide data format.
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Console ~/Desktop/Paper_1/ =0 Coll_Blasco_2006.xIsx 8.4 KB Oct 14, 2018, 2:02 PM
> data("Economy") @ example_read_data.R 1188 Nov 15, 2018, 11:53 AM
> View(Economy) P "
> data("EconomyLong”) example_read_data_malmgquist.R 2918B Nov 15, 2018, 11:56 AM
> View(EconomyLong) R/ Paper_1.Rproj 205 B Nov 15, 2018, 11:51 AM
> data_example_1 <- read_malmqui;t(Ecnnngy, @ gession_1.R 478 Nov 1, 2018, 11:26 AM
+ nper=5,
i arrangement = “horizontal”, session_2.R 1818 Nov 14, 2018, 4:45 PM
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>

As we can see, “data_example_1" is a list of 5 components. If we click on the icon

the name of the object, we can see the structure of this object (see Figure 30).

Figure 30. Structure of “data_example_1".
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SET WA read malmaquist() function with long data format.

Now, we are going to use the dataset “EconomyLong”. The Figure 31 shows the instruction
to adapt the dataset to the reading format in deaR.

Figure 31. read_malmquist() function with long data format.
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O data_example List of 9
U data_example 1 List of 5

" data_example_2 List of

data_example_1 <- read_malmquist(Economy,

1
Z
3
4
5 View(Economylong)
[
7
8

nper=5, -
9 arrangement - “horizontal®, 2 Economy obs. of 16 varigbles
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Save “example_read_malmquist.R”.

7.2.4. read_data_fuzzy() function.

If we are working with uncertain data and we want to measure the efficiency with a fuzzy
DEA model so that deaR can read the data, we have to use the read_data_fuzzy() function to

adapt them first.
deaR can manage trapezoidal, symmetric triangular, and non-symmetric triangular fuzzy
numbers (see Figure 32).
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Figure 32. Fuzzy numbers.

Fuzzy numbers
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d: dR=dL

The read_data_fuzzy() function takes the following arguments?0:

datadea: It is the dataset (It must be a dataframe).

dmus: Number of the column where the DMUs are. By default, deaR considers DMUs
are in the first column of the dataset.

Inputs.mL: Number of the columns where the mL values of the inputs are.
Inputs.mR: Number of the columns where the mR values of the inputs are.
Inputs.dL: Number of the columns where the dL values of the inputs are.
Inputs.dR: Number of the columns where the dR values of the inputs are
Outputs.mL: Number of the columns where the mL. values of the outputs are.
Outputs.mR: Number of the columns where the mR values of the outputs are.
Outputs.dL: Number of the columns where the dL values of the outputs are.
Outputs.dR: Number of the columns where the dR values of the outputs are.
nc_inputs: If we have non-controllable inputs, we can indicate which are them.
nc_outputs: If we have non-controllable outputs, we can indicate which are them.
nd_inputs: If we have non-discretionary inputs, we can indicate which are them.
nd_outputs: If we have non-discretionary outputs, we can indicate which are them.

ud_inputs: If we have undesirable (bad) inputs, we can indicate which are them.

10 See help(read_data_fuzzy).
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e ud_outputs: If we have undesirable (bad) outputs, we can indicate which are them.

Currently, deaR only considers the undesirable inputs/outputs in the fuzzy DEA models
based on the BCC DEA model.

Let’s see it in Example 8.

IETNTJCRR read data_ fuzzy() function.

1. We create a new script. Name it: “example_read_data_fuzzy”.

Note: If we have closed the working session, we open the project “Paper_1" and then
create the new script. We also have to load deaR.

2. We load the dataset “Leon2003”11:
data(“Leon2003”).

This dataset (see Figure 33) has 8 DMUs with 1 symmetric triangular fuzzy input
(alpha is the spread of the input) and 1 symmetric triangular fuzzy output (beta is the
spread of the output).

Figure 33. Dataset: Leon2003.
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Consale /D —[7  Files Plots Packages Help Viewer =0
> Vien(Economy)

> data("EconomyLong”)
> View(EconomylLang)

© Newfolder  © Delete = Rename  {JF More «

7 Home = Desktop = Paper_1

> data_example_1 <- read_malmquist(Economy, A Name size Modified
npersS, t
E i assia it @ RDam 36KB Nov 14, 2018, 4:45 PM
N nis2,
5 no=13 " Rhistory 7.4 K8 Nov 14, 2018, 5:18 PM
> data_example_2 <- read_malmquist(EconomyLong, Coll_Blasco_2006.xlsx 8.4 KB Oct 14, 2018, 2:02 PM
b percal=Z, = = @ example_read_data.R 1188 Nov 15, 2018, 11:53 AM
arrangement = "vertical®,
by b @ example_read_data_malmguist.R 5198 Nov 15, 2018, 11:59 AM
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> data(’Leonz@03") -
> View(Leon20@3) session_L.R 478 Nov 1, 2018, 11:26 AM
@ session_2.R 1818 Nov 14, 2018, 4:45 PM

3. Now, we read_data_fuzzy() to adapt the data. For that, we write into the script:

data_example_3 <- read_data_fuzzy(Leon2003,
inputs.mL=2,
inputs.dL=3,
outputs.mL=4,
outputs.dL=5)

and run it.

11 Leén, T.; Liern, V. Ruiz, J.; Sirvent, I. (2003). "A Possibilistic Programming Approach to the Assessment of
Efficiency with DEA Models", Fuzzy Sets and Systems, 139, 407-419.https://doi.org/10.1016/S0165-
0114(02)00608-5
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Our working session should look like the screenshot below (Figure 34):

Figure 34. Using the read_data_fuzzy() function.
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+ percol=2,
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> dato("Leon2003")

> View(LeonZ0@3) 9 example_read_data.R 1188 Nov 15, 2018, 11:53 AM

> doto_example_3 <- read_data_fuzzy(datadea=Leonz@d3, @ example_read_data_maimquist.R 5198 Nov 15, 2018, 11:59 AM

+ dnuss=1, -
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In this example, inputs.dL=alpha and ouputs.dL=beta. Since we have symmetric
triangular fuzzy numbers: inputs.dL=inputs.dR and outputs.dL=outputs.dR

We have created a new R object: “data_example_3". This object will be the one we
will use to run a given fuzzy DEA model.

We save “example_read_data_fuzzy.R”, close the project and quit RStudio.

7.3. Select and run a DEA model.

Once we have adapted the data to the reading format in deaR, the next step is to select the
DEA model and run it.

In the current version of deaR (version 1.0), the following DEA models are available:

Conventional DEA models

Basic (radial) models (envelopment and multiplier forms)
Directional distance function model

(Weighted) Additive model

Super-efficiency additive model

Radial Super-efficiency model

(Weighted) Non-radial model

Preference Structure model

(Weighted) Slack-based model

(Weighted) Super-efficiency slack-based model
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Conventional DEA models
Cross-efficiency (crs'? and vrs3)

Bootstrapping (Simar and Wilson algorithm)
FDH model

Productivity

Malmquist index

Fuzzy DEA models

Kao and Liu model**

Possibilistic model

Guo and Tanaka model

Fuzzy cross-efficiency® (only crs)

In the documentation for deaR we can find all the details about how to use the different
functions and examples putting them into practice.

Although the DEA models available in deaR are the listed above, given the flexibility in
programming deaR (here is an important strength of the package), the user himself can
experiment, try and implement variants of these models. For example, if the user defines the
weights appropriately in the “Additive model”, MPI®* or RAM!” models can be obtained.
Another example where the user can define weights and obtain different models is from
“Preference Structure Model” (weighted no n radial model). In this case, the user can

VN

calculate the “Cost Efficiency”, “Revenue Efficiency” or “Profit Efficiency” models.

Now, we are going how to use the model basic() function to perform basic DEA models. For
that:

e Open the project “Paper 1" and create a new script. Give it the name:
“example_basic”.

e Load deaR.
e Go to the help for deaR.
e Clic on the model_basic link (see Figure 35). We can also write into the script:

help(“model_basic”)

12 ¢rs = constant returns-to-scale.
13 vrs = variable returns-to-scale.
14 This Fuzzy DEA model has been extended to a several DEA models. See the help for the package:
help(“modelfuzzy_kaoliu”).
15 Based on Guo and Tanaka’s model.
16 Measure of Inefficiency Proportions (MPI).
17 Range Adjusted Measure (RAM).
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Figure 35. Help for the model_basic() function.
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two-stage process (DEA slacks are maximized)

warning message:
package ‘dplyr’ was built under R version 3.4.4 The model_basic function allows to treat with non-discretional, uncontrollable and

> help(package="deaR") undesirable inputs/outputs
>

v < 3

The model_basic() function takes the following arguments:

datadea: It is the dataset (It must be a dataframe).
dmu_ref: Selection of a subset of DMUs.
dmu_eval: DMUs to be evaluated from the selected subset.

orientation: Orientation of the DEA model: input-oriented, output-oriented o
direccional.

dir_input: Input direction vector in directional models.

dir_output: Output direction vector in directional models.

rts: Returns to scale (constant, variable, non-increasing, non-decreasing, generalized).
L: If we select generalized rts, lower bound.

U: If we select generalized rts, upper bound.

Maxslack: By default, slacks are maximized in a second stage.

weight_slack_i: The user can set weights for the input slacks to be maximized in the
second stage.

weight_slack _o: The user can set weights for the output slacks to be maximized in
the second stage.

vtrans_i: With undesirable inputs and variable returns-to-scale, the user can set a
translation vector. By default, the translation vector is (max + 1).

vtrans_o: With undesirable outputs and variable returns-to-scale, the user can set a
translation vector. By default, the translation vector is (max + 1).

compute_target: To calculate the targets for the max slack solution.

compute_multiplier: It returns the multipliers (or weights) of the multiplier form.
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e returnlp: For each DMU, this argument returns the linear problem of the first stage.

Now, we are going to learn how to use the model_basic() function by doing Examples 9 and
10. To follow these examples, we have to load the dataset in deaR: “PFT1981”'8. The dataset
has 70 DMUs (school sites) with 5 inputs (Education, Occupation, Parental, Counseling,
Teachers) and 3 outputs (Reading, Math, Coopersmith). The Figure below (Figure 36) shows
the instructions that we should write into the script “example_basic” to load the data.

Figure 36. Dataset: PTF1981.

@ RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help B D = o) 72% @ Vie16nov 12:07 Vicente Q =
2] @ ~/Desl;:;>/ﬂap;r_1 - RStudio
e - odid ~ Addins ~ % Paper_1 ~
© | example_basic.R* [~  Environment History Connections =M
Filter od “ Import Dataset = = & List =
“ Site Education Occupation Parental Counseling Teachers Reading Math c 'k Clobal Environment =
1 Sitel 86.13 16.24 48.21 49.69 9 5453 58.98 Datg,
2 Sitez 29.26 10.24 41.96 40.65 5 2469 33.89 < PFT1381 7@ obs. of 10 Vﬂﬂﬂt‘les>
3 site3 43.12 1131 38.19 35.03 E] 3641 40.62
4 sited 24.96 6.14 24.81 25.15 7 1494 17.58
5 Sites 11.62 2.21 6.85 6.37 4 7.81 6.94
6 Sites 11.88 497 18.73 18.04 4 1259 16.85
7 Site7 32.64 6.88 28.10 25.45 7 17.06 1699
8 Site8 20.79 12.97 54.85 52.07 8 20.19 30.64 Files Plots Packages Help Viewer i |
9 Sited 34.40 11.04 38.16 42.40 8 2613 29.80 o
10 Sitel0 61.74 14.50 49.09 42.92 9 46.42 51.59 R: Basic (radial) DEA model. ~
11 Sitell 52.92 1167 39.48 39.64 5 39.80  37.73 model_basic {deaR} R Documentation
12 Sitel2 36.00 10.15 37.80 39.52 5 37.84 47.85
13 Sitel3 39.20 10.80 41.04 4112 7

w48 313 Basic (radial) DEA model.

Showing 1 to 14 of 70 entries i
Description

fonsol. Solve input and output oriented basic DEA models (envelopment form) under constant (CCR
DEA model), variable (BCC DEA model), non-increasing, non-decreasing or generalized raturns
filter, lag fo scale. By default, models are solved in a two-stage process (DEA slacks are maximized).
The following objects are masked from ‘package:base’: The model_basic function allows to treat with non-discretional, uncentrollable and undesirable

inputsioutputs.

LntEradct, getditr,.astequal, o Finally, you can use the model_basic function to solve directional DEA models by choosing

> help(package="deaR") orientation = "dir".
> data("PFT1981") i
> View(PFT1981) Usage

5
model_basic(datadea,

dmu_ref = NULL,

dmu_eval = NULL,

orientation = ¢{"io", "oo", "dir"),
dir_input = NULL,

dir output = NULL,

(FETNTJERR model basic() function.

Of 70 DMUs (school sites) in “PTF1981”, there are 49 DMUs in Project Follow Through (PFT)
and 21 DMUs in Non-Follow Through (NFT).

In this example, we are going to calculate the efficiency of the 49 DMUs in PFT by using the
input-oriented CCR DEA moldel.

First, we have to use the read data() function to adapt the data to the reading format in
deaR (see section 7.2.2.). Run the instruction by (- #Rrun on

Now, we have to use the model_basic() function because we want to measure the efficiency
by using the CCR DEA model (a conventional DEA model). But we want to calculate the
efficiency of the first 49 DMUS; that is to say, the DMUs participating in PFT. To make this
selection, we use the argument: dmu_ref=1:49. To evaluate all these units, we use the
argument: dmu_eval=1:49. Therefore, we have to write into the script “example_basic” the
following text:

18 Charnes, A.; Cooper, W.W.; Rhodes, E. (1981). "Evaluating Program and Managerial Efficiency: An Application
of Data Envelopment Analysis to Program Follow Through", Management Science, 27(6), 668-697.
https://pubsonline.informs.org/doi/abs/10.1287/mnsc.27.6.668
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result_pft <- model_basci(PFT1981,

and run it (see Figure 37).

dmu_ref=1:49,
dmu_eval=1:49,
orientation="io”,
rts="crs”)

Note: We can also select all the instructions and run them instead of

doing it instruction by instruction.

Figure 37. Running the input-oriented CCR DEA model for DMUS in PFT.

". RStudio File Edit Code View Plots Session Build Debug Profile Tools

ece
Q - Og g

@] example_basic.R*
Source on Save | (4~

2
3 help(package="deaR")
4

5 data("PFT1981")

6 View(PFT1381)

7
8

9 # Adapting the data to the reading format
1@ data_basic <- read_data(PFT1981,

11 dmus=1,
12 inputs=2:6,
13 outputs=7:9)

result_pft <- model_basic(data_basic,

17 dmu_eval=1:49,

18 dmu_ref=1:49,

19 orientation="io",
20 rts="crs")

21 %

22

211 | (Top Level)

Cansole ~/Desktop/Paper_1
> help(package="deaR")
> data("PFT1981")
> View(PFT1981)
> # Adapting the data to the reading format
> data_basic <- read_data(PFT1981,
dmus=1,
inputs=2:6,
outputs=7:9)
# Running the input-oriented CCR DEA model
result_pft <- model_basic(data_basic,
dmu_eval=1:49,
dmu_ref=1:49,
orientation="io",
rts="crs")

LA A R R B A

~/Deskiop/Paper_1 - RStudio

Window Help [N = o) 72%@) Vie16nov 12:09 Vicente Q =
- Addins - % Paper_1 -
—[7  Environment History Connections =
+Run | =+ Source ~ el # Import Dataset = | & List =
7} Global Environment ~
Data
© data_basic List of 9
) PELIO8 @=abs, of 10 variables
result_pft List of 11
Files Plots Packages Help Viewer =
R Seript
=0

@
R: Basic (radial) DEA model. ~

model_basic {deaR} R Documentation

Basic (radial) DEA model.

Description

Solve input and output oriented basic DEA models (envelopment form) under constant (CCR
DEA model), variable (BCC DEA model), non-increasing, non-decreasing or generalized returns
to scale. By default, models are solved in a two-stage process (DEA slacks are maximized).

The model_basic function allows to treat with non-discretional, uncontrollable and undesirable
inputs/outputs.

Finally, you can use the mode1_basic function to solve directional DEA models by choosing
orientation ='dir".

Usage

model_basic(datadea,
dmu_ref = NULL,
dmu_eval = NULL,
orientation = c("io", "eo", "dir"),
dir_input = NULL,
dir_output = NULL,

ETNJ[WMOR model basic() function.

At this point, could you run the CCR input-oriented DEA model for the DMUs in NFT?
(DMUs in NFT are the DMUs from 50 to 70).

The answer to this question is in next page (Figure 38)
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Figure 38. Running the input-oriented CCR DEA model for DMUs in NFT.

@ Rstudio File Edit Code View Plots Session Build Debug Profile Tools Window Help B 9O = o) 7M%E) Viel6nov 12110 Vicente Q =
@ ® ~(Desktop/Paper_1 - RStudio
o - X o> - ~ Addins - ® paper_1 -
@] example_basic.R* —[7  Environment History Connections ]
Source onSave 4 /- =+Run | *=+ Source ~ " # Import Dataset ~ | & List -
9 # Adapting the data to the reading format 7} Global Envirenment v
18 data_basic <- read_data(PFT1981,
e = Data
12 16, ) data_basic List of 9
13 outputs=7:3) of 10 variables
14
15 # Running the input-oriented CCR DEA model
16 result_pft <- model_basic(data_basic,
17 dmu_eval=1:49,
18 dmu_ref=1:49,
19 orientation="io",
20 rts="crs") Files Plots Packages Help Viewer =
21 _# Runnig hte input-oriented CCR DEA model for DMUs in NFT. D
22z [result_nft <- model_basic(data_basic, E d
23 dmu_eval-50:70, R: Basic (radial) DEA model.
& dmu_ref:? 4 model_basic {deaR} R Documentation
25 orientation="io",
26 rts="crs") 4 h
27 Basic (radial) DEA model.
28
29 s
27:1 | (TopLeved ¢ Rscip - | Description
z 5 Solve input and cutput oriented basic DEA models (envelopment form) under constant (CCR
Console ~/Desktop/Paper_1] . . . i 3
s s b =2 DEA model), variable (BCC DEA model), non-i non-d lized returns
* inputs=2:6, to scale. By default, models are solved in a two-stage process (DEA slacks are maximized).
+ outputs=7:9)
> # Running the input-oriented CCR DEA model The model_basic function allows to treat with non-discretional, uncontrollable and undesirable
> result_pft <- model_basic(data_basic, inputsfoutputs.
b cmLevaia st Finally, you can use the node_bas ic fundtion lo solve directional DEA models by choosing
- dmybafsl 49, orientation = "dir.
+ orientation="io",
+ rts="crs") Usage
> # Runnig hte input-oriented CCR DEA model for DMUs in NFT.
> result_nft <- model_basic(data_basic, model_basic(datadea,
% dmu_eval=50:7@, dmu_ref = NULL,
# dmu_ref=50:70, dmu_eval = NULL,
+ orientation="io", orientation = c("io", "oo", "dir"),
i rts="crs") dir_input = WULL,
K dir_output = NULL,

Save the script “example_basic”.

7.4. Extracting the main results.

In Examples 9 and 10, after running the model_basic() function, all the results are saved in
the objects “result_pft” and “result_nft” respectively. We can see that these objects are a list
of 11 components. We can show the content of each list by clicking on the name of the

object (see Figure 39) or its structure clicking on the blue arrow ({3

).

Figure 39. Structure of the results for a basic DEA model.

= o) 71%@) Vie16nov 12111 Vicente Q

@ RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help G ‘D =
[ RoN ] ~[Desktop/Paper_1 - RStudio
o | Oy - + Addins - E paper_1 -
@] example_basic.R* [T Environment History Connections =
Show Attributes 2 #* Import Dataset + | & List -

Name Type Value "% Global Environment ~

@ result_nft list [11] (53: dea) List of length 11 Data
modelname character (1] ‘basic’ data_basic List of 9
orientation character [1] ‘in" PFT1981 70 obs. of 10 variables
s character (1] o’ List of 11
L double [1] 1 ' result_pft List of 11
u double [1] 1
DMU list [21] List of length 21
data list [9] (53: deadata) List of length 9 Files Plots Packages Help Viewer =0
dmu_eval integer [21] 505152535455 ... @
dmu_ref integer [21] 505152535455 ... e I e mod e
verans_| NULL Pairlist of length 0 model_basic {deaR} R Documentation
virans_o NULL Pairlist of length 0

Basic (radial) DEA model.
(No selection) Description
— =  Solve input and output oriented basic DEA models (envelopment form) under constant (CCR

Console ~/Desktop/Paper_1/

outputs=7:9)
# Running the input-oriented CCR DEA model
result_pft <- model_basic(data_basic,
dmu_eval=1:49,

rts="crs")
# Runnig hte input-oriented CCR DEA model for DMUs in NFT.
result_nft <- model_basic(data_basic,
dmu_eval=50:7@,
dmu_ref=5@:70,
orientation="io",
rts="crs")
View(result_nft)

VOV F o+ VOV 4k VOV 4

DEA model), variable (BCC DEA model), nen-increasing, non-decreasing or generalized returns
to scale. By default, models are solved in a two-stage process (DEA slacks are maximized).

The model_basic function allows to treat with non-discretional, uncontrollable and undesirable
inputs/outputs.

Finally, you can use the model_basic function to solve directional DEA models by choosing
orientation ="dir".

Usage

nodel_basic(datadea,
dmu_ref = NULL,
dmu_eval = NULL,
orientation = c("io",
dir_input = NULL,
dir_output = NULL,

oo", "dir"),
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To extract the main results of the DEA analysis, deaR has a several specific functions. These
functions are:

efficiencies(): To extract the efficiency scores.

slacks(): To extract input and output slacks.

targets(): To extract the input and output target values.
lambdas(): To extract the lambdas (or intensities).
references(): To extract the reference set for inefficient DMUs.

rts(): To extract the returns-to-scale.

N N N N S IR

multipliers(): To extract the multipliers (or weights) of the multiplier DEA
form.

In the following Example 11 we are going to practice with these functions.

SETL MM Extracting the results.

To extract the efficiency scores from “result_pft”, we only have to write into the script the
instruction:

efficiencies(result_pft)
and run it.

The efficiency scores will be shown in the Console, as the following Figure shows.

Figure 40. Efficiency scores of DMUs in PFT.

@ RStudio File Edit Code View Plots Session Build Debug Profile Toocls Window Help G = o) 70%@F Viel6nov 1213 Vicente Q =
o0 e ~/Desktop/Paper_1 - RStudio
C - Of g - - Addins - ¥ Paper_l -
@] example_basic.R* ~—[7  Environment History Connections =
SourceonSave | 4 /- +Run | >+ Source ~ = ~ Import Dataset = & List ~
19 orientation="ic", "k Global Environment -
20 rts="crs") Data
21 # Runnig hte input-oriented CCR DEA model for DMUs in NFT.
22 result_nft <- model_basic(data_basic, ‘data_basic List of 9
23 dmu_eval=50:7@, PFT1981 70 obs. of 1@ variables
2 dmu_ref=50:70, result_nft List of 11
25 orientation="io0",
26 rts="crs™) result_pft List of 11

27 # Ejecutamos el modelo CCR input-orientado para DMUs en NFT.
28 result_nft <- model_basic(data_basic,
29 dmu_eval=5@:7@,

30 dmu_ref=5@:70, Files Plots Packages Help Viewer =
31 orientation="i0", o
32 rts="crs")
33 R: Basic (radial) DEA model. ~
34 = = hamfilloiancy scores model_basic {deaR} R Documentation
35 fefficiencies(result_pft)
36
37 Basic (radial) DEA model.
38
39 aas
36:1  (Top Level) R Script ¢ Description
@ T =0 Solve input and cutput oriented basic DEA medels (envelopment form) under constant (CCR

DEA model), variable (BCC DEA model), non-increasing, non-decreasing or generalized returns

>t Extracting the efficiency scores to scale. By default, models are solved in a two-stage process (DEA slacks are maximized).

> efficiencies(result_pft)
Sitel Sitez Site3 Site4 SiteS Siteé Site? SiteB8 Sited Sitel@® The model_basic function allows to ireat with non-discretional, uncentrollable and undesirable

1.00000 ©.90169 ©.98827 0.90244 1.00000 ©.90689 0.89736 ©.91476 @.87189 1.8000@ inputs/outputs.

Sitell 5SitelZ Sitel3 5Sitel4 Sitel> Sitele Sitel? Siteld 5Sitel? 5Sitez@

©.98194 0.97444 ©.85996 ©.98397 1.00000 0.95030 1.00000 1.00000 @.95@10 1.0000@
SiteZl 5iteZZ SiteZ3 Site24 SiteZ5 Site26 SiteZ7 Site28 SiteZd Site3@

Finally, you can use the model_basic function to solve directional DEA models by cheosing
orientation ="dir".

1.00000 1.00000 ©.96300 1.00000 0.97644 ©0.93714 1.00000 ©.94433 @.84171 0.90255 usage
Site3l 5ite3Z Site33 Site34 Site35 Site36 Site37 Site38 S5ite33 Sited@
©.83922 ©.90698 ©.94022 ©.852086 1.00000 0.80318 0.86141 ©.97015 ©.93515 1.00000 model_basic(datadea,
Site4l Sited4Z Site43 Sited4 Sited5S Site4d Site47 Site48 Sited9 dmu_ref = NULL,
©.94682 0.94735 ©.87076 1.00000 0.83159 0.90873 1.00000 1.00000 1.00000 dmu_eval = NULL,
orientation = ¢("io", "oo", "dir"),
- dir_input = NULL,

i dir_output = NULL,

Similarly, to extract the reference set of the inefficient DMUs we write and execute the
instruction:

references(result_pft)
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The remaining functions (slacks(), targets(), lambdas(), rts(), and multipliers()) work in a
similar way. Try and practice with these functions and pay attention to the results obtained.

7.5. summary() function.

In addition to the previous functions (efficiencies(), lambdas(), etc.), deaR has the summary()
function, which summarizes the results of the DEA analysis. The summary() function serves
to summarize the results of both conventional DEA models and fuzzy DEA models. To use
this function we have to know that it has the following structure:°:

summary(objet, exportExcel = TRUE, filename = NULL)
The arguments of this function refer to:

e object: It is the object to which we have assigned the results of a conventional DEA or
fuzzy DEA model.

e exportExcel: The default value for this argument is TRUE. Therefore, the summary()
function will automatically create an Excel file with the main results in the working
directory. The user can choose not to create the Excel file (exportExcel = FALSE).

e filename: By default, the value of the argument is NULL. Therefore, the default name
of the Excel file will be: "ResutsDEAyear-month-dat_hour:minute:second.xlsx". Of
course, the user can give other name to the Excel file.

As we have said, the way to use the summary() function to summarize the results of a DEA
analysis is identical in both conventional DEA models and fuzzy DEA models. The difference
is found in the summary of the Excel file generated. That is, the sheets of the Excel workbook
created are different depending on the model. Let’s see this in Examples 12 and 13.

Summary of results: conventional DEA model.
Follow the following steps:

1. Open the project “Paper_1".

2. Create a new script: “Summary_DEA”

3. Load deaR.

Assumption: Load the dataset provided by deaR: “Hua_Bian_2007"?°. This dataset has 30
DMUs with 2 inputs (D-Inputl, D-Input2), 2 outputs (D-Outputl, D-Output2) and 1
undesirable output (UD-Outputl) (in this same order).

We want to get the summary of results from the output-oriented BBC DEA model. As there is
an undesirable output, to take this into account in the analysis we will use as the translation
parameter the one used by Hua and Bian (2007): vtrans_o=1500.

1% For more details: help(summary.dea) o help(summary.dea_fuzzy).

20 Hua Z.; Bian Y. (2007). DEA with Undesirable Factors. In: Zhu J., Cook W.D. (eds) Modeling Data Irregularities
and Structural Complexities in Data Envelopment Analysis. Springer, Boston, MA. https://doi.org/10.1007/978-
0-387-71607-7 6
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Important: Remember the steps to use deaR.

Step 1. Load the data.

Step 2. Adapt the data to the format used by deaR.
Step 3. Run the DEA model.

Step 4. Extract the results.

Try it!1!

(the solution is shown in the next page)

©Coll-Serrano, V.; Benitez, R. and Bolds, V. J. (2018)
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Solution: As we can see in Figure 41, to solve Example 12 we have to write into the script
“Summary_DEA” the following instructions:

Step 1. Load the data:

data(“Hua_Bian_2007")

Step 2. Adapt the data:

data_example_12 <- read_data(Hua_Bian_2007,
ni=2,
no=3,
ud_output=3)

Note: We have 3 outputs (no=3) and the third output
is the undesirable output (ud_output=3)

Step 3. Run the DEA model:

result_example_12 <- model_basic(data_example_12,
orientation="00",
rts="vrs”,
vtrans_o= 1500)

Figure 41. Example 12 solution.

#@ RStudio File Edit Code View Plots Session Build Debug Profle Tools Window Help G +O = o) 100%Ed Sib17nov 13:07 Vicente Q =
[ ] ] ~/Deskiop/Paper_1 - RStudio
e - o~ - Addins - K Paper_1 -
[  Environment History Connections =
Source onSave | (4 - +Run | %+ Source - o # Import Dataset ~ & List ~
1 library(dedR} "} Global Environment ~
2
3 | # STEP 1. LOADING DATA: bata
4 | data¢"Hua_Bian_2007") U data_example_12 List of 9
3 Hua_Bian_z@e7 30 obs. of 6 variables
6 | # STEP 2: ADAPTING THE DATA: result_example_12 List of 11
7 || data_example_12 <- read_data(Hua_Bian_2007,
8 ni=2,
9 no=3,
12 ud_output=3)
11
1z | # STEP 3: RUNNING THE DEA MODEL: Files Plots Packages Help Viewer =0
13 || result_example_12 <- model_basic(data_example_12, ©  NewFolder  © Delete = Rename {3 Mare ~
14 orientation="o00", ~ 'S
15 S — & Home  Desktop ~ Paper_l
16 verans_o= 1500) A Name Size Modified
17 t.
13 9 RData 8.3KB Nov 15, 2018, 6:20 PM
| .Rhistory 8.6 KB Nov 17, 2018, 1:03 PM
18:1  (Top Level) = R Script =
Coll_Blasco_2006.xsx 8.4 KB Oct 14, 2018, 2:02 PM
Conanle S (omak o/ PR pec 1 _ =0 @ example_basic.R 1.1 KB Nov 16, 2018, 12:14 PM
Zemiboraty(dedR) @ example_read_data.R 1198 Nov 15, 2018, 6:20 PM
> # STEP 1. LOADING DATA: & i i
+ data("Hua_Bian_2007") example_read_data_fuzzy.R 3178 Nov 15, 2018, 12:03 PM
> # STEP Z: ADAPTING THE DATA: @ example_read_data_malmquist.R 519B Nov 15, 2018, 11:59 AM
> data_example_12 <- read_data(Hua_Bian_20@7, & Paper_LRpro] 2058 Nov 17, 2018, 1:04 PM
ni=2, -
ho=3 @ session_LR 47 B Nov 1, 2018, 11:26 AM
@ session_2.R 1818B Nov 14, 2018, 4:45 PM

ud_output=3)
# STEP 3: RUNNING THE DEA MODEL: . Nov 17, 2018, 1:06 PM
result_example_12 <- model_basic(data_example_12,
orientation="o00",
rts="vrs",
vtrans_o= 1500)

R

v

All the results of the output-oriented BCC DEA model that we have executed can be found in
the object "result_example_12", which is a list of 11 components (see Figure 42).
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Figure 42. Structure of “result_example_12".
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. G piteay Rhistory 8.5 KD Now 17, 2018, 1:03 PM
> # STEP 3: RUMMING THE DEA WODEL: Coll_Blasco_2006.xlsx BAKR Oct 14, 2018, 2:02 PV
> result_example 12 <- model _bosic(data_example 12, © gxample_basic.K 1.1KE Nov 16, 2018, 12:14 PM
T ::,‘ef‘.::,'ﬁm- o 9 example_read_data.R 1198 Now 15, 2018, 6:20 PM
+ vitrans_om 1508 @ example_read_data_fuzzy. R 7E Now 15, 2018, 12:03 PM
> @ ewample_read_data_malmquist.R 5196 Now 15, 2016, 11:59 AM
> .
fl % paper_1.Rproj 2058 Now 17, 2018, 1:04 PM
> @ session_1R ATE Now 1, 2018, 11:26 AM

At this point, we can extract the partial results with the functions:

efficiencies(), lambdas(),

multipliers(), rts(), references(), slacks(), targets(); and the summary of results with the

summary() function.

As the Figure 43 shows, we extract the efficiency scores of the DMUs with the efficiencies()
function. The efficiencies are listed in the Console and assigned to the object "eff". To obtain
the same results as those obtained by Hua and Bian (2007), we write into the script:

and run the instruction.

1/eff

Figure 43. Efficiency scores.

[} File Edit Code View Plots Session Build Debug Profile Tools Window Help G 4O = o) 100% B2 S&b17nov 13114 Vicente Q =
® & ~/Desktop/Paper_1 - RStudio
LR SR } ~ Addins - R Paper_1 -
@) Summary_DEA.R* =) Environment  History Connections o
Source onSave | O - +Run | Source - = g # Import Dataset = | & List =
3 # STEP 1. LOADING DATA: 7k Global Environment -
; data( "Hua_Bian_2007") Data
6 # STEP 2: ADAPTING THE DATA: 0c List of 11
7 data_example_12 <- read_data(Hua_Bian_2007, O data_example_12 List of 9
8 ni=z, " Hua_Bian_z@e7 30 obs. of 6 variables
9 no=3, , 7
% ud_output=3) © result_example_12 List of 11
1 v —
12 # STEP 3: RUNNING THE DEA MODEL: |Named num [1:30] 111.18 1.7 1 |
13 result_example_12 <- model_basic(data_example_12,
14 orientation="00",
15 rts="vrs",
16 vtrans_o= 1500)
o il I ka 1 i
18 [# STEP 4. EXTRACTING (PARTIAL) RESULTS: Lo ez GEerns Gop Ao =0
19 Jeff <- efficiencies(result_example_12) @ NewFolder |9 Delete - Rename | {JF More ~
2 ) ) Home - Desktop - Paper_1 x
E 1/eff # reuslt M5 in table 6-5 (p. 119) A are Sea Modified
17:1 R Script = t .
Console ~/Desktop/Paper_1/ =0 @) RData 8.3K8 Nov 15, 2018, 6:20 PM
> eff ‘Rhistory 8.6 K8 Nov 17, 2018, 1:03 PM
DMUL  DMUZ ~ DMU3  DMU4  DMUS  DMUG  DMU7  DMUS  DMU9  DMULO .
1.00000 1.00008 1.17726 1.86856 1.00000 1.00000 1.81357 1.25406 1.56836 1.00000 o 20 s adm Dalaz0ns. 20z
DMUI11  OMU1Z DMU13 DMUL4 DMULS DMU16 [MUL7 DMUI8  DMU1S  DMUZ@ @ example_basic.R L1ke Nov 16, 2018, 12:14 PM
1.25912 1.00008 1.00274 1.00000 1.00000 1.05994 1.80000 1.05749 1.62927 1.00000 0] example_read_dataR 1198 Now 15, 2018, 6:20 PM
DMUZ1  DMUZZ DMUZ3 DMU24 DMUZ5 DMU26 DMUZ7 DMUZ8  DMU29  DMU3®
@ ?
1.14440 1.00000 1.00000 2.17814 1.7637 1,00000 1.00090 1.00798 1.00000 1.00000 f example_rearl dera fuzy.R a2l i s b
> 1/ef # reuslt M5 in table 6-5 (p. 119) © ] example_read_data_malmguist.R 5198 Nov 15, 2018, 11:59 AM
DMUL DMUZ DMU3 DMU4 DMUS DMUS DMu7 DU 1 Paper_L.Rproj 2058 Nov 17, 2018, 1:04 PM
1.0000000 1.0080000 0.8494300 ©.9358389 1.0000000 1.0000000 0.9866117 0.7974100 & i e -
oMUg DMU0 omu11 oMU12 oMU13 DMUl4  DMULS oMU16 session_L. Sel '
©.6408777 1.0080000 0.7942055 1.9080000 0.2972675 1.0000000 1.0000008 ©.9434496 9] session_2.R 1818 Nov 14, 2018, 4:45 PM
DMUL7 DMU18 DMU19 DMUZ8 oMUZ1 DMUZZ DMUZ3 oMuzZ4 ©) Summary_DEAR 657 8 Nov 17, 2018, 1:12 PM
1.0000000 ©.9456354 0.6137718 1.0000000 0.8738203 1.0000000 1.0800000 0.4638939
DMUZ5 DMUZ6 oMuz7 DMUZ8 DMUZ9 DMU3@
©.7913271 1.0000000 1.0000000 ©.9920832 1.0000000 1.0000000

>
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To get a summary of all the results obtained by running the output-oriented BCC DEA model,

we use the summary() function. We write into the script "Summary_DEA":

summary(result_example_12)

All results are dumped on the Console. Although there are not many DMUs (only 30), there
are many results. It is not practical to use the summary() function to see the results on the
screen. However, as we can see in Figure 44, deaR has also created an Excel file that has all
these results. Notice the name that has been given to the file by default.

Figure 44. Summary of results of the Example 12.

@ RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help [ 4D

= W) 100% B Sdb17 nov 13115 Vicente Q =

[ XoX )
S -op |- ~ Addins -
@ | Summary_DEA.R* i
Source onSave | (4 - +Run | =% Source -
8 ni=2,
9 no=3,
10 ud_output=3)
11
1z # STEP 3: RUNNING THE DEA MODEL:
13 result_example_12 <- model_basic(data_example_12,
14 orientation="00",
15 rts="vrs",
16 vtrans_o= 1500)
17
18 # STEP 4. EXTRACTING (PARTIAL) RESULTS:
19 eff <- efficiencies(result_example_12)
20 eff
21 1/eff # reuslt M5 in table 6-5 (p. 119)
22
23 J# SUMMARY OF RESULTS
24
25 |summary(result_example_12)
26
26:1 | (Top Level) = R Script =
Console op/Pap S — — =0
b R ERTT 0. 0000 1,000
7 0.0002 ©.0000 0.0000 0.9578
8 ©.0000 ©.0000 0.0000 0.2696
9 0.8455 ©.0000 0.0000 ©0.0000
1@ ©0.0000 0. 0000 0.0000 ©0.9000
11 ©0.0000 ©.0000 ©.0000 8.9722
12 8.0000 0.0000 0.0000 0.9000
13 8.2558 0.0000 0.0000 0.9000
14 0.0000 0.0000 0.0000 0.9000
15 @.0000 0.0000 0.0000 0.9000
16 2.0000 ©.0000 ©.0000 2.0000
17 2.0000 0.0000 ©.0000 8.0000
reached aetoetiuns"max.pmnt") -- omitted 13 rows ]
Warning message: e
In rts(object) :

rts function with variable returns teo scale does not make much sense!

>

~[Deskiop/Paper_1 - RStudio

Environment  History ~ Connections.
ol # Import Dataset ~ &
"k Global Environment ~
Data
C List of 11
data_example_12 List of 9
Hua_Bian_2@87 3@ obs. of 6 variables
result_example_12 List of 11
Values
eff Named num [1:36] 1 1 1.18 1.87 1 ...
Files Plots Packages Help Viewer
©  NewFolder © Delete - Rename {J More ~
4 Home = Desktop = Paper_1
4 Name Size
L.
@ .RData 8.3 KB
“| .Rhistory 8.6 KB
Coll_Blasco_2006.x|5x 8.4 KB
@ example_basic.R 1.1KB
@ example_read_data.R 119 B
@ example_read_data_fuzzy.R 3178
@ example_read_data_malmquist.R 519B
R Paper_1.Rproj 205B
@ session_LR 47 B
9 session_2.R 181 B
@ summary DEA.R 657 B
1 ResultsDEAZ018-11-17_13:15.07.xlsx | 14.9 KB

& Paper_1 -

=0

List ~

=0

Modified

Nov 15, 2018, 6:20 PM
Nov 17, 2018, 1:03 PM
Oct 14, 2018, 2:02 PM
Nov 16, 2018, 12:14 PM
Nov 15, 2018, 6:20 PM
Nov 15, 2018, 12:03 PM
Nov 15, 2018, 11:59 AM
Nov 17, 2018, 1:04 PM
Nov 1, 2018, 11:26 AM
Nov 14, 2018, 4:45 PM
Nov 17, 2018, 1:12 PM
Nov 17, 2018, 1:15 PM

Open the Excel file to see how the results are shown (see Figure 45). To do this, we click on
the file "ResutsDEAyear-month-dat_hour:minute:second.xlsx " and select the option "View

file".
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Figure 45. Summary results in Excel.

@ Excel Archivo EdiciSn Ver Insertar Formato Herragai = B torine 22 [h *’D = o) 100% B Sab17 nov 12:48 Vicente Q =
@ D I [F ResultsDEA2018-11-17_12/35/11.xlsx (Sélo \eclura)l
PECSA® XDES 96 E-% F @0 6 one © @ )
| #onicio | Diseio | Tablas | Graficos | SmartArt | Férmulas | Datos | Revisar | |~ 2~

Editar Fuente Alineacion Ndmera Formato Celdas H Temas
= [#] Retlenar +[caliori (cverpol [+[11 [+]| A= A~ [=] |aber | 50 Austartexto + - General | : %. &:ﬂ. . [Aay. BE-
Pegar 05""3’ T m_c__i . - | = & - BT @%'ﬂﬂ fi_g__f,ﬂ :m;!?r\gona\ o insertar Eliminar Formato | Temas Aar
(i1 90 E Ao 2

=t | € | D | E | F [ & | H©H [ 1 [ 3 | k [ L [ M [ N [ © | P | © [ R | s | T [ uw [ v | w []=
| omu §eff
2 |DMUL 1
3 |oMu2 X
4 |omu3 117726
5 |DMu4 1,06856
6 |DMUS i
7 |DMUG i
8 |DMu? 1,01357
9 omus 1,25406
10 omug 1,56036
11 |pMul0 1
12 |pMu1l 125812
13 | pmu12 1
14 |DMU13 1,00274
15 |DMU14 1
16 |oMU1s 1
17 |DMUl6 1,059%4
18 pmu1? £
19 |omMuis 105749
20 |DMU19 1,62927
21 |DMU20 1
22 |omu21 1,1444
23 |DMU22 1
24 |pMuU23 1
25 |DMU24 2,12814
26 |DMU25 12637
27 |DMU28 1
28 |omu27 1
29 |DMu28 1,007%8
30 |DMU29 S
31 |omu3o i
32
33
34
35
36
37
38
39
— << k> 1efﬂclenc|¢_u slacks | lambdas | targets | returns | referencesJ+J [i

=

vista normal Tete Suma=0 - >

We save the script “summary_DEA”.

Now, in Example 13 we are going to replicate the results in Ledn, et al. (2003)%%.

SETNTJEWEN Summary of results: Posibilistic fuzzy DEA model.

Ledn et al. (2013) use possibilistic programming techniques to measure the efficiency based
on the envelopment form of the input-oriented BCC model. Data used by the authors in their
article can be found in the dataset "Leon2003", which is provided by deaR.

We create a new script: "Summary_DEA fuzzy". To replicate the results that the authors
show in Table 2 (page 419), we write into the script:

data("Leon2003")

data_example <- read_data_fuzzy(Leon2003,
dmus=1,
inputs.mL = 2,
inputs.dL =3,
outputs.mL =4,
outputs.dL = 5)

result <- modelfuzzy_possibilistic(data_example,
h=seq(0, 1, by = 0.1),
orientation = "io",
rts = "vrs"

efficiencies(result)

21 |éon, T.; Liern, V. Ruiz, J.; Sirvent, I. (2003). "A Possibilistic Programming Approach to the Assessment of
Efficiency with DEA Models", Fuzzy Sets and Systems, 139, 407-419. https://doi.org/10.1016/S0165-
0114(02)00608-5
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Note: h =seq (0, 1, by = 0.1) generates a sequence of
values for the different levels of possibility: h = (0, 0.1, 0.2, ..., 1).

We run the instructions. The efficiency scores of the BCC input-oriented model will be shown
for the different levels of possibility h in the Console (see Figure 46)

Figure 46. Efficiency scores for different h-levels.

# RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help [ <D = o) 84%[@E Lun19nov 2:31 Vicente Q =
[ ] @ ~[Desktop/Paper_1 - RStudio
¢ -0 - ? + Addins ~ & Paper_L =
(7 Environment History Connections =0
Source on Save | O - +Run | %% Source ~ g “ Import Dataset - & List ~
1 library(deaR) "} Global Envirenment +
z
3 [dataC“Leonzee3") b -
4 [data_example <- read_data_fuzzy(Leon20@3, data_example List of 9
5 dmus = 1, Leonz@e3 8 obs. of 5 variables
6 inputs.ml = 2, result List of 10
7 inputs.dL = 3,
E outputs.mL = 4,
9 outputs.dL = 5)
10
11 fresult <- modelfuzzy_possibilistic(data_example,
12 h = seq(@, 1, by = 0.1),
13 orientation = "io",
14 rts = "vrs") = =
15 Jefrictenciescresutt) Files Plots Packages Help Viewer = ]
16 © NewFolder © Delete = Rename {3 More -
17 £ Home © Desktop ~ Paper_1 R
18 A g <
17:1 | (Top Level) R Script = 3 Name size Modified
Sty = [Dakive Tepr | e — ) =0 @) RData 83KB Nov 15, 2018, 6:20 PM
> result <- modelfuzzy_possibilistic(data_example, *| .Rhistory 10.9 KB Nov 17, 2018, 1:16 PM
= alpho=: s6q(0, 1, by:=8.1), Coll_Blasco_2006.xIsx 8.4 KB Oct 14, 2018, 2:02 PM
+ orientation = "io",
a pie o Myme"y) @ example_basic.R 1.1 KB Nov 16, 2018, 12:14 PM
> efficiencies(result) @ example_read_data.R 1198 Nov 15, 2018, 6:20 PM
2. 0.z 2.3 0.4 0.5 2.6 0.7 8.8 2.9 1
@ .
A 1.00000 1.00000 1.00000 1.08000 1.90000 1.09000 1.00000 1.06000 1.00000 1.00000 1.90000 example_read_data_fuzzy.R 318 Now 152018, 12000
B 1.60000 1.00000 1.00000 1.00000 ©.97674 0.94118 ©.98476 0.86747 ©.82927 0.79012 0.75008 9 example_read_data_malmquist.R 5198 Nov 15, 2018, 11:59 AM
C 1.60000 1.00000 1.00000 1.00000 1.00000 1.00000 1.00000 1.00060 1.00800 1.00060 1.00008 $ Paper_1Rproj 2058 Nov 19, 2018, 2:30 AM
D ©.75000 ©.73957 ©.72919 0.70809 ©.68529 0.66204 ©.63831 0.61410 ©.58939 0.56419 0.53846 & - :
E 0.64286 0.63377 0.63685 0.63105 0.62439 0.61719 0.60940 0.60099 ©.59189 0.55206 ©.57143 sesslon; 1 are Nov1r2015; 11:26/AM
F ©.60504 ©.59527 ©.58571 0.56597 ©.54458 0.52273 ©.50041 0.47761 B.45432 0.43054 0.40625 @ session_2.R 1818 Nov 14, 2018, 4:45 PM
G 1.00000 1.00000 1.00000 1.00000 1.80000 1.00000 1.99000 1.00000 1.00000 1.00000 ©.45000 & Summary DEAR &ib T b e
H 2.69231 ©.68992 ©.68750 0.68504 0.66667 0.64000 ©.61290 @.58537 ©.55738 ©.52893 0.5000@ T
I @) Summary_DEA_fuzzy.R I 5678 Nov 19, 2018, 2:29 AM

To get a summary of the results on the screen (see Figure 47) and export them to an Excel
file, we write the following instruction into the script and run it:

Figure 47. Summary of results for the possibilistic input-oriented BCC DEA model.
@ RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help B = o) 83% @ Lun19nov 2:31 Vicente CU:=
[ ] [ ] ~/Deskiop/Paper_1 - RStudio
e - >~ - Addins - K Paper_ 1 -
0| summary_DEA_fuzzy.R* —["]  Environment History Connections =
Source onSave | (4 - +Run | =+ Source ~ o # Import Dataset + | & List »
% 7k Global Environment -
3 data("Leon20@3")
4 data_example <- read_data_fuzzy(leonZ@@3, Data
5 dmus = 1, data_example List of 9
6 ?nputs.mL =2, Leon2@03 8 obs. of 5 variables
£ inputs.dL = 3, result List of 10
3 outputs.mL = 4,
9 outputs.dL = 5
19
11 result <- modelfuzzy possibilistic(data_example,
1z h = seq(@, 1, by = 8.1),
13 orientation = "io",
14 rts = "vrs")
8 B orricienciesCresult) Files Plots Packages Help Viewer =
16 @ NewFolder | © Delete - Rename |} More -
i AY Home - Desktop - Paper_1 b
ig 4 Name Size Modified
18:1 | (Top Level) = R Script t.
@] .RData 8.3 KB Nov 15, 2018, 6:20 PM
Console ~/Desktop/Pape =0
-Rhistory 10.9 KB Now 17, 2018, 1:16 PM
2 L 9 D000 00000000 1 oL Coll_Blasco_2006.xIsx 8.4 KB Oct 14, 2018, 2:02 PM
7% D 8.9 ©.56419 @.6583 0.0000 0.3417 @ 0 @ @ @
7 E 0.9  0.58206 0.3167 0.0000 0.6833 6 0 0 0 © 9] example basic.R L1KB Nov 16, 2018, 12:14 PM
78 F 8.9 ©.43854 @.8167 0.0000 0.1833 @ 0 @ @ @ @) example_read_data.R 1198 Nov 15, 2018, 6:20 PM
7?6 2.9 1.00000 0.0000 ©.0000 0.0000 @ @ @ 1 @
[ 3
@ H 2.9 0.57893 1.0000 0.0000 0.0000 @ 0 © © © example_read_data_fuzzy.R 317 B Nov 15, 2018, 12:03 PM
81 A 1.0 1.90000 1.0000 0.0000 0.0P00 @ & @ 0 @ ©] example_read_data_malmguist.R 5198 Nov 15, 2018, 11:59 AM
2 B 1.8 ©.75000 1.0000 0.0000 0.0000 @ 0 0 0 @ B Paper_1.Rpro| 205 B Nov 19, 2018, 2:30 AM
83 C l.e 1.00000 0.0200 ©.0000 1.0000 @ 0 @ 0 @
[ :
8 D 1.0 0.53846 0.6667 ©.0000 0.3333 0 0 0 0 0 e L i e oo
85 E 1.0 ©.57143 ©.3333 0.0000 0.6667 @ 0 @ @ @ @ session_2.R 1818 Nov 14, 2018, 4:45 PM
86 F 1.0 0.40625 0.8333 0.0000 0.1667 0 0 0 0 © © Summary_DEA.R 6618 Nov 17, 2018, 1:16 PM
87 G 1.@ ©.45000 0.0000 0.0000 1.0000 @ @ @ @ @ & f ’
8 H 1.6 ©.50808 1.0000 ©.0008 0.0000 @ 0 @ @ 0 summaty DEATUE=Y-R. 3628 Dov 19: 2013, 2:23 AM
I ResultsDEAZ018-11-19_02:31:36.xlsx I 8.2 KB Nov 19, 2018, 2:31 AM
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For the possibilistic model, the summary of results consists of: (1) the efficiency scores and
(2) the reference sets. These are the results that are exported to the Excel workbook (see
Figure 48).

Figure 48. Summary results in Excel.

= o) 83% M Lun18nov 2:32 Vicente Q =
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e T e o e T e L T e e e
1 Iy B 3 D 3 F S 7 |
Fan 0 T T 3 g O O 5 g 0
3 [s ] 1 a 1 0 ] ] [} [ a
4 c [ 1 [ [ 1 [] [} [} [} [
o ] 075 a (5 05 0 f] f] o a
6 [E o Dcaz86 o o 0T ] [] o [} [
At o 060504 o osma 0 ] 0 ] 0 [
8 s ] 1 a a 0 ] ] ] 1 a
9 [n o ogo3L [ 1 0 ] o o [} [
0 |a 01 1 1 a 0 0 o ] 0 [
ais a1 1 a 1 0 ] ] [} o a
12 |c 01 1 [ [ 1 [] [} [} [} [
FEal 01 g73857 o os071 04929 0 f] f] o a
14 [e 01 ogwT 0 01571 0ga2d ] [] o [} [
a5 [r 01 o59527 o osss7 04143 ] ] ] 0 a
16 [c a1 1 a a o ] ] ] 1 a
aru 01 osssa [ 1 0 [] [} [} 0 [
8 [a 02 1 1 a 0 0 o ] 0 [
a9 [s 02 1 a 1 0 ] ] [} o a
20 [c 02 1 [ [} 1 [] [} [} [} [
Zip 02 o791 o 05143 o487 o ] f] 0 a
22 e 02 06368 0 01714 08285 ] ] o [} [}
23 |r 02 osss7 [ 08 04 ] ] ] 0 a
2ac 02 1 a a 0 ] ] ] 1 a
25 [n 02 o8 [ 1 0 [] [} [} 0 [
26 |a a3 1 1 a 0 0 o ] 0 [
27 s LE 1 [ I 0 [] o ] [ [
2B [c 03 1 [ [ 1 ] 0 0 [ [
29 |p 03 070808 06083 a o317 0 ] ] o a
30 [E 03 063105 02187 o o3 ] ] o [} [}
31 03 056597 07167 o 02833 ] ] ] 0 a
32c a3 1 a a o ] ] ] 1 a
33 [n 03 068504 [ 1 0 ] [} [} [} [
34 |a 04 1 1 a 0 ] o ] 0 [
35 |8 04 0976 1 [} 0 ] o [] [} [}
36 [c 04 1 [ [ 1 ] 0 0 0 [
37 0n R a 23 P P P P a
G
Vista normal Listo Suma=0 v

We save the script “Summary_DEA_fuzzy”.

7.6. Graphical results. The plot() function.

With the plot() function we can obtain some plots of the results from a conventional DEA
model, Malmquist index or cross-efficiency model. This is shown in Examples 14, 15, and 16
respectively.

The plot() function is used in the following way:
plot(x)
where x is the object in which the result of a DEA model has been stored.

After using the plot() function, we will get the plot in the Viewer (right bottom window). We
can save a plot by clicking on the Export tag of the Viewer. It is possible to save the plot as an
image in format: “png”, “jpeg” or “tiff’. We can copy the plot to the system clipboard and
then paste it, for example, in a word document.

Graphs for fuzzy DEA models are not available still in this version of deaR.

We are currently working to improve the graphical results in deaR, which will be included in
the next version.

SETL TN Plot: Basic DEA model.

We open the script “Summary_DEA”. If we have closed the working session, we need to
open the project “Paper_1”, load deaR, and open the script.
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Our working session should be similar to the one shown in Figure 49.

Figure 49. Script “Summary_DEA”.

RStudio File Edit Code View Plots Session
eCc e

Build Debug Profile Tools Window Help [ O

Z W) 57% @) Dom25nov 19:24 Vicente Q =

~/Deskiop/Paper_1 - RStudio

o -y i = Addins - % paper_l — Desktop -
© | Summary_DEA.R = ["]  Environment History Connections e
Source on Save | O /- *Run | "= Source ~ - # Import Dataset = | & List ~
1 library(deaR) % Global Environment +
z
3 # STEP 1. LOADING DATA:
4 dataC"Hua_Bian_20@87") T —
c v ent is empty
6 # STEP 2: ADAPTING THE DATA:
7 data_example_12 <- read_data(Hua_Bian_z@e7,
8 ni=2,
9 no=3,
10 ud_output=3)
11
12 # STEP 3: RUNNING THE DEA MODEL:
13 result_example_12 <- model_basic(data_example_12, Files | Plots Packages Help Viewer =)
14 orientation="o0", - =
15 rts="vrs" © NewFolder | © Delete = Rename = {f More -
16 vtrans_o- 158@) £ Home - Desktop = Paper_1 b
17 A Name Size Modified
18 # STEP 4. EXTRACTING (PARTIAL) RESULTS: T+
19  eff <- efficiencies(result_example_12) 1
20 eff @ RData 8.3 KB Nov 15, 2018, 6:20 PM
21 1/eff  # reuslt M5 in table &-5 (p. 119) _Rhistory 11.2 KB Nov 19, 2018, 3:07 AM
22 )
23 # SUMMARY OF RESULTS Coll_Blasco_2006.xlsx 8.4 KB Oct 14, 2018, 2:02 PM
24 @] example_basic.R L1KB Nov 16, 2018, 12:14 PM
25  summary(result_example_12) @] example_read_data.R 1198 Nov 15, 2018, 6:20 PM
26
@) example_read_data_fuzzy.R 3178 Nov 15, 2018, 12:03 PM
26:1 | (Top Level) & R Script ¢ @ example_read_data_malmquist.R 5198 Nov 15, 2018, 11:59 AM
Console ~/Desktop 1/ =0 & Paper_l.Rproj 2058 Nov 25, 2018, 7:23 PM
o ‘help.start()’ para abrir el sistema de ayuda HTML con su navegador. @] session_L.R 478 Nov 1, 2018, 11:26 AM
Escriba "q()' para salir de R. @] session_2.R 1818 Nov 14, 2018, 4:45 PM
@ summary_DEA.R 6618 Nov 17, 2018, 1:16 PM
[Workspace loaded from ~/Desktop/Paper_l/.RData]
@ summary_DEA_fuzzy.R 5758 Nov 19, 2018, 3:07 AM

>

As Figure 50 shows, we select from line 1, library(deaR), to line 16 and run the selection.

Immediately, three objects

listed in

“Hua_Bian_2007" and “result_example_12".

Figure 50. Running the script.

the Environment:

“data_example_12",

@ RStudio File Edit Code View Plots Session

Build Debug Profile Tools Window

Help G 4O

2 o) 57% @) Dom26nov 19:24 Vicente Q =

[ XN ) ~/Desktop/Paper_1 - RStudio
S - O - - Addins - I paper_l — Desktop -
@ | Summary_DEAR = [7  Environment History Connections ==
Source on Save = - SRun | = Source = - # Import Dataset ~ | & List +
1 1library(deaR) "} Clobal Environment =
2
3 # STEP 1. LOADING DATA: 4
4 data( "Hua_Bian_2007") data_example_12 List of 9
5 Hua_Bian_2007 3@ obs. of 6 variables
6 # STEP 2: ADAPTING THE DATA: result_example_12 List of 11
7 data_example_12 <- read_data(Hua_Bian_2@07,
ni=;
9 no=3,
10 ud_output=3)
11
12 # STEP 3: RUNNING THE DEA MODEL:
13 result_example_12 <- mude1_ba51c(dutn_gxample_12, Files | Plots Packages Help Viewer -
14 orientation="o00 -
15 rts="vrs", @ NewFolder | @ Delete «|Rename = {Jf More ~
16 vtrans_o= 1508) 4 Home - Desktop - Paper_1 R
17 4 Name Size Modified
18 # STEP 4. EXTRACTING (PARTIAL) RESULTS: £
19 eff <- efficiencies(result_example_12) =
20 eff .RData 8.3 KB Nov 15, 2018, 6:20 PM
Z1  1/eff # reuslt M5 in table 6-5 (p. 119) .Rhistory 11.2 KB Nov 19, 2018, 3:07 AM
22
Coll_Blasco_2006.xIsx 8.4 KB Oct 14, 2018, 2:02 PM
23  # SUMMARY OF RESULTS - N
24 9] example_basic.R 1.1 KB Nov 16, 2018, 12:14 PM
25 summary(result_example_12) | example_read_data.R 1198 Nov 15, 2018, 6:20 PM
26
9| example_read_data_fuzzy.R 3178 Nov 15, 2018, 12:03 PM
L1 (Top Level) = R Script = @ | example_read_dara_malmguist.R 5198 Nov 15, 2018, 11:59 AM
Console - 2 - &' Paper_l1.Rproj 2058 Nov 25, 2018, 7:23 PM
> # STEP 3: RUNNING THE DEA MODEL: 21 session_1.R A7.8 Nov.1.:2018.:11:2 AM
> result_example_12 <- model_basic(data_example_12, 9 session_2.R 1818 Nov 14, 2018, 4:45 PM
& ortemations o0, @ summary_DEA.R 6618 Nov 17, 2018, 116 PM
+ rts="vrs",
& vtrans_o= 1580) 9 summary_DEA_fuzzy.R 5758 Nov 19, 2018, 3:07 AM
>

The results of the DEA model are assigned to (or stored in) the object “result_example_12".
To plot some of these results, we will write the following instruction on the line 27 of the
script:
plot(result_example_12)
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and run it. The following message will be displayed in the Console:
Press [enter] to continue

and a plot will be shown in the Viewer tag (right bottom window), as we can see in Figure 51.

Figure 51. Example 12, Graphic 1.

u' RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help ] {D = o) 48% @) Lun26nov 16:57 Vicente Q =
[ NoN ) ~/Desktop/Paper_1 - RStudio
S - R Todil = Addins - & paper_1 — Desktop -
] plot_example_12.R = ["]  Environment History Connections =
Source on Save | (4 - +Run | "= Source ~ | = - # Import Dataset = | & List ~
i’ S e % Global Envirenment =
12 # STEP 3: RUNNING THE DEA MODEL: Data
13 result_example_1Z <- model_basic(data_example_12Z, © data_example_12 List of 9
& orientations-oag, © Hua_Bian_2007 30 obs. of 6 varicbles
15 rts="vrs", = e f
16 vtrans_o— 1500) © result_example_12 List of 11
17 Values
18 # STEP 4. EXTRACTING (PARTIAL) RESULTS: eff Named num [1:36] 1 1 1.18 1.07 1 ...
19 eff <- efficiencies(result_example_12)
20 eff

Z1  Llreff # reuslt M5 in table 6-5 (p. 119)

22
23 # SUMMARY OF RESULTS Hissl]| ot mbzcases;|[Help =
24 ' @ Zexpor - (O ghalbeblshiy

25  summa result_example_12 = 3 i R .
% g i ? Efficient/Non Efficient DMUs Non-efficient DMU distributio
27 fplot(result_example_12) 5 &
27:24 R Script ¢ 18 i
Consale ~/Desktop/Paper_1/ =0
7 ©.0000 0. 0000 0.0000 ©0.3578
8 2.0000 ©0.0000 0.0000 2.0696 N
9 0.0455 .0000 ©.0000 0.0000 10
10 2.0000 .0000 .0000 ©.0000 =3 z
1 0.0000 ©.0000 ©.0000 0.0722 é §
12 ©.0000 .0000 0.0000 ©.0000
13 8.2558 .0000 0.0000 ©.0000 4
14 2.0000 ©.0000 .0000 2.0000 5
15 0.0002 0. 0000 0.0000 0.02000
16 ©.0000 0. 0000 0.0000 ©.2000
17 ©.0002 0. 0000 0.0000 ©0.0000
[ reached getOption("max.print”) -- omitted 13 rows ] &
12 15 18 21

> plot(result_example_12) Non-efficient Efficient E
Press [enter] to continue Efficiency

This Graphic 1 shows the number of efficient and inefficient DMUs (right graph), and the
distribution of the efficiency score of the latter as well (left graph). If we click on the Zoom
bottom, the plot will be enlarged (see Figure 52).

Figura 52. Enlarge plot.

ﬂ' RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help &y {D = W) 50% W) Lun26nov 16:52 Vicente Q =

o . og {888 it zoom
{ Efficient/Non Efficient DMUs Non-efficient DMU distribution
©  graficos_| -
: 2 b List -

o
7 datc
8

i Paper_1 — Deskiop ~

12 %Pl
13  resy

18 #Pf 10
19 eff|
20 eff
21 1/ef &
E

22
23 xrRE'S

=0

4 Publish ~

icient DMU distribution

Count

27 plot

Console

14
15
16

iz 9 II I
1.5 1.8 21

[ reached
> plot(res Non-efficient Efficient 12 15 1.8 21 k
Press [ent Efficiency | Efficiency
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Now, if we press the Enter key, a second graphic will be displayed. On this occasion, what is
depicted is the number of times an efficient DMU is part of the inefficient DMUs reference
set.

Figure 53. Example 12, Graphic 2.

u' RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help ] {D = o) 48% @) Lun26nov 16:57 Vicente Q =

[ ] @ ~/Desktop/Paper_1 - RStudio
e - R Tndi = Addins - % paper_1 — Desktop -
) plot_example_12.R = ["]  Environment History Connections ]
Source on Save | (4 - +Run | "= Source ~ | = - # Import Dataset = | & List ~
i’ e i ) 7k Global Environment =
1Z # STEP 3: RUNNING THE DEA MODEL: Data
13 result_example_12 <- model_basic(data_example_12, © data_example_12 List of 9
& orientation="oo;, © Hua_Bian_2007 30 obs. of 6 variables
15 rts="vrs", = e
6 vtrans_o- 1509) © result_example_12 List of 11
17 B Values
18 # STEP 4. EXTRACTING (PARTIAL) RESULTS: eff Named num [1:38] 11 1.18 1.@7 1 ...
19 eff < efficiencies(result_example_12)
20 eff
21 1/eff # reuslt M5 in table 6-5 (p. 119)
2z
23 # SUMMARY OF RESULTS Files Plots Packages Help =0
24 ® zoom | -Z Export v v <% Publish =
25 summary(result_example_12)
26 DMU30 1
2 plotlresuls_exomple_12) ozs{ - N &
Console ~/Desktop/Paper_1/ oo ovee) N
ST — oz | I 3
8 ©.0000 0. 0000 0.0000 ©0.0696 ~
omuzz [ 2
E} 0.8455 0. 0000 0.0000 0.2000 5 DMU20 -1
1e ©0.0002 0. 0000 0.0000 ©0.0000 g ;
1 9.0000 0.0008 0.0800 0.0722 = DMuT? [k
12 0.0000 @.0000 @.0000 0.0008 3 DMUHS [ i
13 0.2558 0.0000 0.0000 0.0000 & omuay [
14 0.0000 0.0000 0.0000 0.0000 Wonuizy
15 ©.0000 .0000 0.0000 ©.0000 omuio{ [
16 2.0000 .0000 ©.0000 2.0000 owus{ [
17 2.0000 ©.0000 ©.0000 2.2000 omus] |0
5
[ reached getOption("max.print") -- omitted 13 rows ] :
. omuz{ |0
> plot(result_example 12) DMUT 10
Press [enter] to continue 0 3 [ k]

Press [enter] to continug # times appearing in reference sets

Finally, by pressing the Enter key again we can see the last graphic (see Figure 54).

Figure 54. Example 12, Graphic 3.

® RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help G <D = W) 48%mE )
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DXiDI0
i pxi12 ® s
16 \
17 D14
18 # STl
19 eff «
20 eff
21  1/efy
2z
23 # sun

Lun 26 nov 16:57 Vicente Q =

Plot Zoom

 Paper_1 — Desktop ~

=0

List ~

o :

81071 ...
i@ @7
N tannd . R Y
o1 D@3 ’
24
25 sumn DI.l? D.‘.I} D.’E& D..‘I
26
27 plot D,\.lﬁ Dl’.Zi
Console - I T Dr.g'lgr.?f.24 b0 b

27:24 (Toy
9 DMUS

10
1n Dz JDMU2
12

3 pifilies [.e Di27 "ZZSEDM_H

14 I
24PMDI30

=0

“%- Publish ~

15
16
17
[ reached
>
> plot(resy
Press [ente
Press [ente
>

IMRI29
127

In Figure 54 we see a network graph in which the green circles represent the efficient DMUs
and the red circles the inefficient ones. This graph shows how inefficient DMUs are related
to efficient DMUs, trying to convey the idea that the efficient ones form the efficient
frontier. In addition, notice that not all green circles have the same size. In this case, the size
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of the circle aims to convey the idea of how important is the efficient DMU for the set of
inefficient DMUs.

We save the script as: “plot_example_12".

SETNTJEWEN Plot: Malmquist index.

We create a new script with the name “plot_malmquist”. If we have closed the working
session, we need to open the project “Paper_1”, load deaR, and create the script.

Now, we are going to run the Malmquist index. For that, we write into the script:
data("EconomylLong")

data_example_15 <- read_malmquist(EconomylLong,
percol = 2,
arrangement = "vertical",
inputs = 3:4,
outputs = 5)
result_malmquist <- malmquist_index(data_example_15,
orientation = "io"

Note: The data are in long format.

We run the instructions of the script (see Figure 55).

Figure 55. Running the Malmquist index.

@ RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help G ED) = o)) 55% @) Dom 25nov 19:28 Vicente G =
@ [ ] ~[Desktop/Paper_1 - RStudio
o -| o B . - Addins - % Paper_1 — Desktop ~

@ | plot_example_12.R @ | plot_malmaquist.R* [T Environment History Connections =0
Source ¢ +Run | "+ Source - ond ~ |mport Dataset ~ | & List v
1 Hata("EconomyLong") ) Clobal Environment =
2 data_example_15 <- read_malmquist(Economylong,
Data
3 percol = 2, N
4 arrangement = "vertical®, 0 e QDL ol 5L 0D
5 inputs = 3:4, data_example_15 List of 5
6 ) o outputs = 5) EconomyLong 155 obs. of 5 variables
7 result_malmquist <- mlmqu1st_mdex(data_exaryple_l?r ; Hiua.Bian. 2007 30 obs. of 6 variables
8 orientation = "io")
9 result_example_12 List of 11
10 I result_malmquist List of 14 I
Files Plots Packages Help Viewer =
@ NewFolder | © Delete =+ Rename {3k More ~
/&) Home - Desktop - Paper_1 ¥ ..
4 Name Size Modified
@] .RData 8.3 KB Nov 15, 2018, 6:20 PM
L1 (TopLevel) 3 R Script 3
| .Rhistory 11.2 kB Nov 19, 2018, 3:07 AM
Console ~/Desktop/Paper_1 =0 Coll_Blasco_2006.xIsx 8.4 KB Oct 14, 2018, 2:02 PM
>
> # STEP 3: RUNNING THE DEA MODEL: 91 example_basic.R 1.1K8 Nov 16, 2018, 12:14 PM
> result_example_12 <- model_basic(data_example_12, @] example_read_data.R 1198 Nov 15, 2018, 6:20 PM
£ oiaiiiceiimains @ example_read_data fuzzy.R 3178 Nov 15, 2018, 12:03 PM
+ rts="vrs",
+ vtrans_o= 1500) © 1 example_read_data_malmquist.R 5198 Nov 15, 2018, 11:58 AM
> data("Econcmylong™) & Paper_1.Rproj 2058 Nov 25, 2018, 7:23 PM
> data_example_15 <- read_malmquist(Economylong, &1 session_1.R 478 Now 1, 2018, 11:26 AM
+ percol = 2,
+ arrangement = "vertical”, O] session_2.R 1818 Nov 14, 2018, 4:45 PM
+ inputs = 3:4, @ | summary_DEA.R 6618 Nov 17, 2018, 1:16 PM
: DULPUILS =2 Q] s DEA_fi R 5758 Nov 19, 2018, 3:07 AM
> result_malmquist <- malmguist_index(data_example_15, et ) R i
+ orientation = "io") @] plot_example_12.R 6858 Nov 25, 2018, 7:26 PM
>

I 97 plot_malmquist.R I 4038 Nov 25, 2018, 2:20 PM

The results of the Malmquist index are stored in the object “result_malmquist”. Therefore,
to get the plots we write into the script:

plot(result_malmquist)
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and run the instruction. The following message will be displayed in the Console:
Press [enter] to continue

By pressing the Enter key a plot will be shown in the Viewer (right bottom window) (see
Figure 56). We can click on the Zoom to see the plot better. In this first plot, for each DMU
the Malmquist index and its components are drawn over the years. If there are many DMUs
you will not probably see them very well. However, it is possible to select the DMUS the
DMUs of your interest to focus on them (and the other DMUs in the graph will disappear).

Figure 56. Malmquist index: Graphic 1.

@ RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help G O = o) 54% @) Dom25nov 19:30 Vicente Q =
[ ] [ ] ~[Desktop/Paper_1 - RStudio
© -0 |- ~ Addins - ® paper_1 — Desktop -
O | plot_example_12.R @] plot_malmquist.R* == [7]  Environment History Connections i
Source on Save | (i - +Run | *+ Source ~ > “ Import Dataset = & List ~
1 data("EconomylLong") ) Global Environment -
2 data_example_15 <- read_malmquist(EconomylLong,
Data
3 percol = 2,
4 arrangement - "vertical”, U data_example_12 List of @
5 inputs - 3:4, O data_example_15 List of 5
6 outputs = 5) EconomylLong 155 obs. of 5 variables
7 result_malmquist <- ma'Lmqu1st,mdex(data,exal?tple,l.?, ) Hua_Bian_2007 30 obs. of 6 variables
E orientation = "io")
9 result_example 12 List of 11
18 plot(result_malmquist) result_malmquist List of 14
11
Files Plots Packages Help -
¥ Zoom | -I Export “- Publish =
L2
=]
=
z p— 8 1‘24’/‘\__ Anhui |
11:1 | (Top Level) * R Script * 5 = — - y Beijing
Console ~/Desktop/Paper_1/ =0 & —— Chongging
> result_example_1Z <- model_basic(data_example_1Z, £ 1‘4.———"—__—-“—-.‘ —— Fujian
+ orientation="00", E lf—ﬁ—:—iﬁ ~—— Gansu
+ rts="vrs"
. Guangdong
+ vtrans_o= 1500) D i‘;_(-——’ — o
” - S . Guangxi
> data("EconomylLeng™) i —— — - Guizh
> data_example_15 <- read_malmguist(Econcmylong, 0.9 b
+ percol = 2, bei Hainan
+ arrangement = “vertical”, oo — Hebei
+ inputs = 3:4, & — Heilongjiang
+ outputs = 5) E Henan
> result_malmquist <- malmquist_index(data_example_15, Lo —— Hubei
s orientation = "io") g —— Hunan
> plot(result_malmquist) E 2006 2007 2008 2009

Press [enter] to continue
Press [enter] to continue

Period

If we press the Enter key (in the Console) again, a second plot is created (see Figure 57).

Figure 57. Malmquist index: Graphic 2.

@ RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help B <O = o) 54% @) Dom25nov 19:30 Vicente Q =
[ ] [ ] ~[Desktop/Paper_1 - RStudio
e - R o - - Addins - % Paper_1 — Desktop -
@ | plot_example_12.R @ | plot_malmaquist.R* | Environment  History Connections =M
Source on Save = 4 - +Run | 4 Source o ~ |mport Dataset + | & List
1 data("Economylong”) 7} Clobal Environment =
2 data_example_15 <- read_malmguist(EconomylLong,
Data
3 percol = 2, :
4 arrangement = "vertical”, data_example_12 List of 9
5 inputs = 3:4, data_example_15 List of 5
6 outputs = 5) EconomyLong 155 obs. of 5 variables
7 result_malmguist <- mlmqu1st,mdex(da‘ta,exaryple,l‘S., ; ) Hua_Bian_2@07 30 obs. of 6 variables
8 orientation = "i0")
g result_example_12 List of 11
18 plot(result_malmquist) result_malmquist List of 14
11
Files Plots Packages Help ewer =l
| # Zoom | -Z Export -| Q s <5 Publish =
S T T Efficiency change
- opLevel = it & Malmquist index
Console ~/Desktop/Paper_1 -1 Productivity change
+ orientation="o00", Scale change
+ rts="vrs", ik Technical change
+ vtrans_o= 1508)
> data("EconomyLong”) 9
> data_example_15 <- read_malmguist(Economylong, ®°
+ percol = 2, =
+ arrangement = “vertical”, 1.05
$ inputs = 3:4,
& outputs = 5)
> result_malmquist <- malmquist_index(data_example_15,
i orientation = "io") ’
> plot(result_malmquist) 4
Press [enter] to continue 2006 2007 2008 2009
Press [enter] to continue N
Period
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dR

On this occasion, the geometric means of Malmquist index and its components are drawn
over the years. We can enlarge the plot by clicking on the Zoom and go back (or go forward)
by clicking on the arrows. Here, it is possible to select the Malmquist index components to
be shown.

We save “plot_malmaquist”.

SETTJEHEN Plot: Cross efficiency.

We create the new script “plot_cross_efficiency”. If we have closed the working session, we
need to open the project “Paper_1", load deaR, and create the script.

We write and run the followings instructions (see Figure 58):
data("Golany_Roll_1989")
data_example <- read_data(datadea = Golany_Roll_1989,

dmus=1,
inputs = 2:4,
outputs = 5:6)
result_cross <- cross_efficiency(data_example,
orientation = "io",

rts = "crs",
selfapp = TRUE)

Figure 58. Script of cross efficiency.

®@ RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help G +O 2 o) 53% @) Dom25nov 19:32 Vicente Q =
[ NN ) ~(Desktop/Paper_1 - RStudio
e - g i - Addins - & Paper_l — Desktop -
& plot_example_12.R T e [~ Environment History Connections =
Source on Save | 4/ - +Run | v+ Source ~ r # Import Dataset ~ & List -
1 hﬂta("Gulanyjou,lBBB“) "} Global Envirenment -
2 data_example <- read_data(datadea = Golany_Roll_1989, =
3 dmus = 1,
4 inputs = 2:4, data_example List of 9
5 outputs = 5:8) data_example_12 List of 9
6 result_cross <- cross_efficiency(data_example, data_example_15 List of 5
it ur\ent?tlu:l =0 EconomyLong 155 obs. of 5 variables
8 rts = "ers”, I_my = -
9 selfapp - TRUE) Gulany,RulleSQ E obs. of & vumablesl
1@ Hua_Bian_Z@@7 3@ obs. of 6 variables
I result_cross List of 13 I
Files Plots Packages Help Viewer =0
O NewFolder | @ Delete - Rename {JF More -
/2 Home - Desktop  Paper_1 B .
A Name Size Modified
] .Rhistory 11.2 KB Nov 19, 2018, 3:07 AM
Ll | (Top Level) * R Script =
Coll_Blasco_2006.xIsx 8.4 KB Oct 14, 2018, 2:02 PM
consolaie [Duskinp Bapar 1 =0 @ example_basic.R L.1KB Nov 16, 2018, 12:14 PM
> result_malmquist <- malmquist_ingex(data_example_15,
s orientation = "io") @ example_read_data.R 1198 Nov 15, 2018, 6:20 PM
> plot(result_malmquist) @ example_read_data_fuzzy.R 3178 Nov 15, 2018, 12:03 PM
Press [enter] to continue @ example_read_data_malmquist.R 5198 Nov 15, 2018, 11:59 AM
Press [enter] to continue
> data("Golany_Roll_1989") L Paper_1.Rproj 205 B Nov 25, 2018, 7:23 PM
> data_example <- read_data(datadea = Golany_Roll_1989, @ session_1.R 47B Nov 1, 2018, 11:26 AM
dmus = 1,
= s @ session_2.R 181 B Nov 14, 2018, 4:45 PM
+ inputs = 2:4,
+ outputs = 5:6) @] Summary_DEA.R 661 B Nov 17, 2018, 1:16 PM
> result_cross <- cross_efficiency(data_example, @] Summary_DEA_fuzzy.R 575 B Nov 19, 2018, 3:07 AM
Iy orientation = ilon e I le_12.R 685 B Nov 25, 2018, 7:26 PM
* rts = "crs”, plot_example_12. ov 25, X
+ selfapp = TRUE) 9 plot_malmquist.R 403 B Nov 25, 2018, 2:20 PM
= 1 @ plot_cross_efficiency.R | 416 B Nov 25, 2018, 7:19 PM

In the object “result_cross” are stored the results of the cross efficiency corresponding to
the models: arbitrary, benevolent and aggressive. All these results are drawn like a heat map
by using the plot() function. For that, we write into the script:

plot(result_cross)
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and press Enter in the Console to display the different graphs. The result should be similar to
the one shown in Figure 59.

Figure 59. Graphs of cross efficiency.
u' RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help & {l)
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e - R Tndi - 4 - Addins - % paper_1 — Desktop -
SourceonSave | (4, # - +Run | "= Source ~ | = = # Import Dataset ~ | & List ~
1 data("Golany_Roll_1983") "} Global Environment =
2 data_example <- read_data(datadea = Golany_Roll_1989,
Data
3 dmus = 1, =
4 inputs = 2:4, 0 data_example List of 9
5 outputs = 5:6) @ data_example_12 List of 9
6 result_cross <- cress_efficiency(data_example, © data_example_15 List of 5
7 orientation = "io", ~ =
g rts = "crs”, :EmnomyLung 155 obs. of 5 variables
9 selfapp = TRUE) O Golany_Rol1_1989 13 obs. of 6 variables
1@ plot(result_cross) © Hua_Bian_zeo7 3@ obs. of 6 variables
1 O result_cross List of 13

=0

“%- Publish =

Files Plots Packages Help

J® Zoom | - Export -

Arbitrary Method

111 | (Top Level) = R Script = o
Console ~/Desktop/Paper_1/ =0 0.6
> plot(result_malmquist)

Press [enter] to continue 0.4
0.2

Press [enter] to continue
> data("Golany_Roll_1989")
> data_example <- read_data(datadea = Golany_Roll_1989,

+ dmus = 1,

+ inputs = 2:4,

+ outputs = 5:6)

> result_cross <- cross_efficiency(data_example,

+ orientation = "io",
+ rts = "crs”,

selfapp = TRUED

b
> plot(result_cross)

Press [enter] for next plot
Press [enter] for next plot

We save the script “plot_cross_efficiency”, close the project and quit RStudio.
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